
CARIS HIPS and SIPS 8.1

Reference



Copyright (c) 2013 CARIS All rights reserved.

The material in this manual is for information purposes only and is subject to change without notice. CARIS 
assumes no responsibility for any errors that may appear in this manual. CARIS hereby grants licensees of CARIS 
software the right to reprint this document for internal use.

CARIS 
(Global Headquarters)
115 Waggoners Lane
Fredericton, NB
Canada
E3B 2L4

Phone: 1 (506) 458-8533 
(English/French/Spanish)
Fax: 1 (506) 459-3849
Email: info@caris.com
Assistance: support@caris.com
Web site: www.caris.com

CARIS USA
415 N. Alfred Street
Alexandria, VA
United States
22314

Phone: 1 (703) 299-9712
Fax: 1 (703) 299-9715 
Email: carisusa@caris.com

CARIS bv
Mgr. van Oorschotstraat 13
PO Box 47 5473 ZG
Heeswijk, NETHERLANDS

Phone: +31 (0)413 296 010
Fax: +31 (0)413 296 012
Email: sales@caris.nl
Assistance: support@caris.nl

CARIS Asia Pacific
Level 3 Shell House, 172 North Terrace
Adelaide SA 5000
Australia

Phone: +61.(0).8.8231.9474
Email: info@caris.com

Trademarks
CARIS, CARIS software and the CARIS logo are registered trademarks or 
trademarks of CARIS.
All other registered trademarks or trademarks are property of their respective 
owners. 
Data courtesy of the Shallow Survey Conference Common Data Set 2001 (CCOM - 
UNH).
Acknowledgements
The development of HIPS and SIPS as a modern and powerful bathymetric and side 
scan sonar processing system was made possible through the cooperation of several 
organizations:

• The Canadian Hydrographic Service (CHS)
• The Ocean Mapping Group of the University of New Brunswick
• The National Oceanic and Atmospheric Administration (NOAA) 

August 2013



3

Preface

This guide describes the HIPS and SIPS interface and how it works. It also 
describes the options that control the layout and appearance of the 
interface.

“THE HIPS AND SIPS INTERFACE” ON PAGE 9
“DISPLAY WINDOW” ON PAGE 12
“PROPERTIES WINDOW” ON PAGE 18
“OPTIONS” ON PAGE 91
“MENUS” ON PAGE 27

“DATA DIRECTORIES” ON PAGE 131
“HIPS STATUS FLAGS” ON PAGE 137
“CONTACT FILE FORMATS” ON PAGE 139
“TIDE FILE FORMATS” ON PAGE 147
“SUPPORT FILES” ON PAGE 159
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The HIPS and SIPS Interface

This chapter describes the interface and its components (menus, toolbars 
and windows), and how projects and background data can be viewed. 
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The HIPS and SIPS Interface: Opening HIPS and SIPS

Opening HIPS and SIPS
1. To open HIPS from the Windows interface, select Start > Programs > 

CARIS > HIPS and SIPS version number > CARIS HIPS and SIPS

During installation you were prompted to place a 
HIPS icon on the desktop. If you selected this 
option you can also open HIPS and SIPS by 
double-clicking this icon. 
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The HIPS and SIPS Interface: Main Interface

Main Interface
The HIPS and SIPS interface is composed of a menu bar, various 
toolbars, four main windows, and a status bar (see “STATUS BAR” ON 
PAGE 36).

The Menu bar (see “MENUS” ON PAGE 27) and toolbars (see “TOOLBARS” 
ON PAGE 34) can be hidden from display, or moved to other 
locations on your desktop. Windows can be undocked and moved 
to another location, resized, or hidden (see “DISPLAY, REPOSITION AND 
RESIZE WINDOWS” ON PAGE 25).

Display window

Worksheet window Status bar

Control window

Properties window

. Toolbars

. Menu bar
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The HIPS and SIPS Interface: Display Window

Display Window
The Display window shows graphical representations of the 
survey data. To select data such as track lines in the Display 
Window, that layer must first be highlighted in the Layers tab of 
the Control Window.
To open the Display window:
1. Select the Display window command.

• select track lines, soundings or contours (see “QUERY DATA” ON 
PAGE 269).

• zoom and pan data (see “ZOOM” ON PAGE 39 and “PAN” ON PAGE 38).
• view imagery files (see“OPEN BACKGROUND DATA” ON PAGE 46) and 

S 57 data (see “DISPLAY S-57 DATA” ON PAGE 53).
• save screen captures of the display in the window (see “SCREEN 

CAPTURES” ON PAGE 41).
• define a field sheet area (see “CREATE A FIELD SHEET” ON PAGE 170).
• display a temporary geographic or projected grid over the 

extent of your project (see “GEOGRAPHIC GRID” ON PAGE 102 or 
“PROJECTED GRID” ON PAGE 108). 

You can also open a range of files such as GeoTIFF, HOB, S-57 
and JPEG as background files. (see “ DISPLAY BACKGROUND DATA” ON 
PAGE 45 for full description.

Pop-up menu When you right-click in the Display window, a pop-up menu 
gives you access to a variety of commands. (Commands which 
are greyed out are not available for the current data.) 
These commands include: 
• viewing commands such as Overview and Zoom
• tools such as the Attitude, Navigation and other HIPS and 

SIPS editors, 
• editing commands such as Cut, Paste and Copy Position
• Query and Sort functions
• save the content of the display as an image
For options for the display of the ship and towfish track lines see 
“DISPLAY WINDOW” ON PAGE 100.

M
en

u

Window > Display

To
ol

s
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The HIPS and SIPS Interface: Control Window

Control Window
The Control window has three tabbed windows: Project, Layers, 
and Draw Order. 
A fourth tabbed window will be available when you open a HIPS 
and SIPS editor, such as the Mosaic Editor or Attitude Editor.

Project tab
The Project tab displays the currently open project.
You can expand the tree by clicking the plus sign (+) to reveal 
the layers of the Project/Vessel/Day/Line hierarchy. A green 
check mark in the check box for each line indicates that the line 
is visible in the Display window. By default all lines are visible.

You can perform the following operations in this window:
• open and close lines (see “CLOSE A PROJECT” ON PAGE 42)
• select track lines (see “QUERY DATA” ON PAGE 269)

For information on working with projects, see "CREATE A NEW 
PROJECT" in the CARIS HIPS and SIPS User Guide. 

Highlighting on a 
line indicates it is 
selected in the 
Display window.

The red !  icon 
indicates that this 
line is Outdated.

The red X icon 
indicates that this 
line is Rejected. 

An empty check 
box indicates the 
line is not visible in 
the Display 
window..
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The HIPS and SIPS Interface: Control Window

Layers tab
The Layers tab lists the open data layers. Control what is viewed 
in the Display window by selecting or clearing the check boxes 
for the various layers. 
Besides survey data, a layer can consist of a BASE Surface, a 
BASE surface attribute layer, a CARIS map, an image, or field 
sheet products such as contours, selected soundings, tiles, etc.

1. Expand the file tree by clicking the + icon beside it.

2. Show/hide the display of a layer (in the Display window) by selecting or 
clearing the check box beside the layer name. (See also “TOGGLE 
VISIBILITY OF LAYERS” ON PAGE 15.)

3. Selecting a layer (so that it is highlighted) makes it the active layer. The 
data in that layer can now be selected in the Display window. 

4. Select Use Coordinate System from the pop-up menu to apply the 
coordinate system from a layer to the view of data in the Display 
window. For an example of changing the coordinate using a 
background data layer, see “USE COORDINATE SYSTEM” ON PAGE 48.

Background 
file layers

Active layer

BASE surface 
and attribute 
layers

Mosaic and 
attribute 
layers

Tile layer

The exclamation point 
indicates that the layer 
is outdated.

Field sheet layer. 
The green outline 
indicates this is the 
active field sheet.
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5. To update the Display, window select the Refresh command.

• Or turn on the Automatic Refresh option in the General Options 
dialog box (see “GENERAL” ON PAGE 93).

BASE surfaces can be grouped together in the Layers tab in 
order, for example, to apply the same display properties to the 
attribute layers of multiple surfaces simultaneously. See “GROUP 
MULTIPLE SURFACES” ON PAGE 238. 

Toggle visibility of layers You can also toggle many layers on and off at the same time. The 
parent layer (for example, a BASE surface layer) controls the 
visibility of its child layers (such as the attributes layers). 
• When the check box for a parent layer is cleared, all selected 

child layers of the parent layer are also cleared. None of the 
layers is visible in the Display. (In the example below, the 
BASE surface H16-2011parent layer is turned off as are all 
its attribute layers.

• When the parent layer check box is selected again, any of the 
child layers that were selected at the time the parent layer 
was cleared, are also re-selected. These child layers are now 
visible again in the Display. (In the example below the Depth 
and Bounding Polygon are selected.) 

M
en

u
View >Refresh 

To
ol

s
Ke

y F5



16 CARIS HIPS and SIPS Reference
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• If you select all the child layers, you can toggle them all on 
and off using the parent layer check box. In the following 
example all the child layers of H16-2011 have been toggled 
on.

Draw Order tab
The Draw Order tab displays the order that objects are drawn to 
the Display window. Objects are drawn in order, from top to 
bottom, as they appear in the Draw Order tab. You can change 
the draw order by dragging an object to another position on the 
list, as illustrated below. 
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Tab for HIPS and SIPS editors
When you open the Attitude, Navigation, Swath, Subset or 
Sidescan Editor, a fifth tab will be displayed in the Control 
window. It will contain the controls for the active editor. 
For example, the Swath Editor tab contains 3 tabbed pages: 
• The General tab controls the data display in the Swath Editor 

windows.

• The 3D tab contains the Swath 3D view controls.
 
• The WCI tab controls display options for the water column 

imagery windows. 
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Properties Window
The Properties window displays the properties of lines, surfaces 
and features that are listed in the Layers tab and selected in the 
Display window. 
The properties shown in the window are determined by the type 
of layer selected, that is, ship track lines, field sheet and BASE 
Surface layers will display different properties, and not every 
layer displays properties.
The Properties window can be undocked and moved around the 
interface.
1. Select the Properties window command.

2. Select a layer in the Layers tab of the Control window.

The display properties for that layer are shown in the window. 
The example shown below shows properties for the Ship Track 
Line layer.
 

For more information on viewing and setting properties for 
specific layers, see the following in the HIPS and SIPS User 
Guide:
• “SET LINE PROPERTIES” ON PAGE 67

• “CRITICAL SOUNDINGS” ON PAGE 293

• “VIEW PROJECT PROPERTIES” ON PAGE 63

• “VIEW VESSEL PROPERTIES” ON PAGE 66

• “PROPERTIES OF BASE SURFACES” ON PAGE 200

• “SET FIELD SHEET PROPERTIES” ON PAGE 177 for Field Sheet layers.
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Worksheet Window
The Worksheet window has two tabs which are visible at all 
times while HIPS and SIPS is open: Output tab and Selection 
tab.
• Output (for viewing the result of a command or process).
• Selection (for viewing information on selected data)
• QC Reports (for displaying quality control reports)

Output Tab
In this tab you can view the results of a command or process.

Information in this tab is read-only and cannot be modified.
If you want to remove the information in this tab, right-click the 
mouse and select Clear from the pop-up menu.
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Selection Tab
When you select features such as lines, soundings or contours in 
the Display window, their data profiles are automatically 
displayed in the Selection tab. 
To see this information for data selected in a HIPS and SIPS 
editor, use a Query command. See “QUERY DATA” ON PAGE 269 in the 
User Guide.
The example below displays the data profiles for four selected 
lines. The line highlighted in the table is the line that is 
superselected in the Display window.
 

Data profiles in the Selection tab are shown in tabular format, 
with a column for each data field. Records in a column can be 
sorted by clicking on the column header. This will sort the 
records by ascending or descending order of the values in the 
column. 
This data is read only. However, it can be saved to a text file 
using the command on the pop-up menu. 
Which columns are displayed, and the order in which they are 
displayed, is controlled by the pop-up menu. To set which data to 
display:
1. Right-click on a column header in the Selection tab.

2. Select columns by name from the list on the pop-up menu, or select 
More to open the Column Settings dialog box. 

Column Settings Use the Column Settings dialog box to determine the column 
headings to be displayed. The example below shows the column 
headings for contacts selected in the Display window. 
 

The left side of the dialog box lists headings that are available 
but not currently visible, and the right side lists the column 
headings currently displayed in the Selection tab
3. Use the <-- and --> buttons to move the headings from one column 

to the other.
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4. Use the Up and Down buttons to change the order in which they are 
shown in the Selection tab.

5. To adjust the width of a column, select it in the right-hand list and type 
the desired width in pixels. (Column width can also be set manually in 
the Selection tab by dragging the right or left edge of a column header.) 

6. To restore the default listing of fields and their order, click Reset.

7. Click OK.

See also “QUERY DATA” ON PAGE 269.

QC Reports Tab
The QC Reports tab contains statistical data generated from the 
QC Reports tool on the Process menu. For details on creating QC 
reports, see “QUALITY CONTROL REPORTS” ON PAGE 303.

You can customize display of data in the QC Reports tab in the 
same manner as in the Selection tab. See “SELECTION TAB” ON PAGE 20 
for more information.
You can also create graphs of this data using the Graph tool. 
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Detailed Line Query Window
The Detailed Line Query window can display a table of more 
than 50 columns of detailed line information for a selected line 
or lines. This is activated using the Detailed Line Query 
command on the Process menu. (See “DETAILED LINE QUERY” ON 
PAGE 270.)
Which data is visible and in what order it is displayed is 
controlled using the Column Settings dialog box from the right-
click menu. (See “COLUMN SETTINGS” ON PAGE 20.)
As with the Selection tab, records in a column can be sorted by 
clicking on the column header.
This information can be saved to a text file, using the Save As 
command on the right-click menu.
To save a customized selection of the data, see “LINE REPORT” ON 
PAGE 271.
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Process Log Window
HIPS automatically creates a text Log file in the line directory for 
each line, recording the operations that are applied to the line. 
The Process Log window, opened from the Window menu, 
displays the process log for a superselected line. 
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Processes are listed in the left hand column in chronological 
order, with the earliest applied process at the top of the list and 
the latest process applied at the bottom of the list.
Processes that can be displayed include:

• Conversion
• Load Tide
• Load Delta Draft
• Load True Heave
• Sound Velocity Profiles applied
• Merge
• Compute TPU
• Compute GPS Tide
• Load Error Data
• Load Attitude/Navigation Data
• Shift Navigation
• Beam Pattern Correction
• Recompute Towfish Navigation
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Display, Reposition and Resize Windows
Display The Display, Worksheet and Control windows are open in the 

default HIPS and SIPS layout, but they can be closed, and re-
opened by clicking the appropriate button on the Window 
toolbar, or in the Window menu. 

Reposition All windows can be undocked from their default positions and 
moved within the HIPS interface or to positions on your desktop. 
1. Click and hold your cursor on the title bar or handle of the window and 

drag the window to the new position.

As you drag the cursor, the window un-docks from its current 
location and moves with the cursor.
2. Release the mouse button when you want to position the window in its 

new location.
 

To prevent a window from automatically docking within the 
interface, hold the <Ctrl> key while dragging the window.
A floating window can be restored to its last docked position by 
double clicking on its title bar. 

Re-size Windows can also be sized to a new length and width.
1. Position the cursor on any edge of the window.

The cursor becomes a two-headed arrow.

ControlDisplay Worksheet

Click handle and drag
to undock

Double-click title
bar to re-dock 
window 
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2. Press and hold the mouse button and drag the edge of the window to a 
new position.

As you drag the cursor, the window expands or contracts, 
depending on whether you are pulling or pushing the window 
edge.
3. Release the mouse button when you have resized the window to the 

desired length and width.

Restore default 
windows layout

You can close all editors open in the HIPS and SIPS interface, 
and reset the interface windows (such as the Control window) to 
the same position as when the application was first installed.
1. Select the Restore Default Window Layout command.

You will be prompted to save data as editors are closed.M
en

u Window > Restore 
Default Window 
Layout
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Menus 
Most HIPS and SIPS commands can be accessed from menus on 
the menu bar at the top of the interface. The following is an 
outline of the commands available. 
For an alphabetical listing describing all the HIPS and SIPS 
commands, see the "COMMAND OVERVIEW" in the HIPS and SIPS 
Tools guide.
The functions of the various commands are described within the 
workflow outlined in the HIPS and SIPS Users Guide. 

File menu Use the File menu commands to open, save and close projects, 
sessions and field sheets and to open background data. 
It also contains the commands for importing and converting data 
and for exporting processed data to various formats, as well as a 
access to the Vertical Reference Editor.
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Edit menu This menu contains editing commands such as Undo, as well as 
data cleaning commands to reject, accept and query data.
Commands to query tile soundings and to create a tile 
histagram, as well as viewing and editing commands for LIDAR 
data are also listed. 
Vessel, SVP and Tide Editors can also be opened from the Edit 
menu. 
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View menu Commands on the View menu enable you to change the display 
of data with Zoom and Pan, Refresh, Change Projection and 
Centre on Selection commands. 
Commands to display and manipulate data in 3D, and to record 
3D “fly-throughs” are also on the View menu as well as 
commands to display specific data such as rejected data.
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Tools menu Use the Tools menu commands to run batch processing, 
interpolation or shifting of navigation data, set and apply filters, 
measure distances and create beam pattern correction files. 
As well, SingleBeam, Subset, Swath, Side Scan and Mosaic 
Editors can be opened from the Tools menu. 
HIPS and SIPS options can also be set from the Tools menu.
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Process menu From the Process menu you can create field sheets and QC 
reports, load corrections such as TrueHeave and tide, compute 
TPU and SVC and then merge your data. 
The commands to create and work with BASE surfaces, Product 
surfaces and products such as contours are also on the Process 
menu. Imagery corrections such as Beam Pattern Correction can 
be applied from the Process menu. 
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Select menu Commands on the Selection menu enable you to select data by 
range or by lasso, to select all data, or only the data in the 
display. 
There are also commands to enable you to move through data 
line by line. 
 

Window menu From the Windows menu you can display, hide and arrange the 
main HIPS and SIPS windows, view project properties and 
restore the arrangement of windows in the HIPS and SIPS 
interface to that of the initial install. 
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Help menu From this menu you can open the Help file and view information 
about the version of HIPS and SIPS you have installed.

Many of these commands on menus are also accessible from 
toolbars. For a description of these toolbars, see "HIPS AND SIPS 
TOOLBARS" in the HIPS and SIPS Tools Guide.
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Toolbars 
Toolbars allow swift access to commonly used commands. 
Toolbars can be undocked and moved about the desktop or 
hidden from view until needed. 
The HIPS and SIPS toolbars are: 
• Standard: activate standard Windows commands such as 

opening and saving files.
• Edit: activate functions used for editing data.
• View: activate functions for controlling the view in the 

Display window.
• Tools: activate functions for opening editors and for 

processing data.
• Process: activate functions for executing processes such as 

creating BASE surfaces and merging.
• Filter: activates functions for defining and executing 

automatic filters.
• Select: activate functions for selecting objects in the Display 

window.
• Window: activate commands for toggling windows to on or off.
• Swath Editor: activate functions for examining and cleaning 

pre-merged sounding data.
• Single Beam Editor: activate functions for examining and 

cleaning single-beam data.
• Subset Editor: activate functions for examining and cleaning 

sounding data in the subset mode.
• Side Scan Editor: activate functions for examining data, 

slant-range correcting raw side data, and creating contacts.
• Process Side Scan: activate
• LIDAR activate functions for selecting and examining 

soundings recorded by a LIDAR system.
• Surface Cleaning: activate functions for surface cleaning and 

tiling.
• Beam Pattern: activate functions for creating and adjusting 

beam patterns for use in beam pattern correction.
• Mosaic Editor: activate functions for creating GeoBaRs and 

Mosaics and Sediment Analysis.
For a fuller description see “HIPS AND SIPS TOOLBARS” ON PAGE 10 in 
HIPS and SIPS Tools.
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Display Toolbars
Most toolbars are visible when the application is opened, 
arrayed below the menu bar. Toolbars can be undocked from this 
location and positioned within the HIPS and SIPS interface, or 
on your desktop. 
To display toolbars not currently open:
1. Select the View Toolbars command.

2. On the Toolbars sub-menu, click on the toolbar name that you want to 
display.

The toolbar is displayed the desktop. To hide the toolbar, reverse 
the process.

Move toolbars Toolbars can be moved to any location on the desktop.
1. Position the cursor over any area of the toolbar not covered by a 

button. 

2. Press and hold the mouse button while dragging the toolbar to a new 
location.

3. Release the mouse button to position the toolbar.

Toolbars will automatically dock when they are close to certain 
areas of the HIPS interface. To stop the toolbar from 
automatically docking, hold down the <Ctrl> key while moving 
the toolbar.
To return the toolbar to its previous position in the interface, 
double-click on the toolbar’s title bar. 
 

Modify button size You can alter the appearance and size of toolbar buttons.
1. Select the Customize command.

The Customize dialog box is displayed.
2. Select any of the following three options by checking a box.

• Tool Tips: Display the name of a command button when the cursor is 
placed over it.

• Cool Look: Remove the border outline from the buttons.
• Large Buttons: Display buttons with 32 x 32 pixel icons instead of 

16 x 16 pixel icons.

3. Click OK.

Custom toolbar You can also create a custom toolbar (see “CREATE A CUSTOM TOOLBAR” 
ON PAGE 24 in HIPS and SIPS Tools).

M
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View > Toolbars

The Menu bar can be repositioned in the same way as 
toolbars.
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Status Bar
The status bar at the bottom of the interface displays the 
following information:
• a message about the operation currently taking place, or the 

information in the tool tip for the command button or menu 
item your cursor is on 

• the number of track lines selected out of the total lines open 
in the interface

• the scale of the current display in the Display window (when 
in the 3D Display window this field shows the “height” of the 
flight above the surface.)

• the coordinates of the current cursor position in the units 
chosen in Tools > Options (see also “COPY POSITION” ON PAGE 37)

• disk usage for a selected data repository 

Depending on which editor you have open, the status bar will 
also display information such as the day the survey was 
conducted, profile and beam number, etc. 

Status Bar options
You can hide the status bar: 
1. Select the Status Bar command.

The check mark beside the Status Bar option is gone and the 
status bar is no longer visible in the desktop.

Cursor coordinates The units for the coordinates of the cursor’s current position are 
set in the Options dialog box of the Tools menu. You can use the 
Units option to set the type of unit e.g. Geographic or Ground. 
The Position Precision option is used to set the number of places 
to the right of decimal point in the coordinate display. 
For further information see “UNITS” ON PAGE 119.

M
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View > Status Bar
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Copy Position
This command enables you to copy the coordinates of the current 
position of your cursor in the Display window. The coordinates 
are copied to the clipboard. 
To copy the position under your cursor in the Display window:
1. Right-click on the position in the Display window.
2. Select Copy Position from the pop-up menu.

3. Open a text editor such as Notepad, and Paste the coordinates into the 
editor. 

Alternatively, click in the Display window at the point from 
which you want to copy the coordinates, and select Copy Position 
from the Edit menu. 
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Data Viewing tools
There are two kinds of tools that you can use to manipulate the 
view of data in the Display window: Pan and Zoom. The Pan 
function lets you reposition your view within the Display 
window. The Zoom function magnifies or reduces the viewing 
area within the Display window.
The Zoom/Pan Reverse and Forward tools let you toggle between 
views, and you can zoom to centre on a specific set of coordinates 
using the Zoom To command. 

Pan
There are two ways to move the view of data up, down, or to the 
left or right, within the Display window: 
• by using the Pan tool to move by a defined amount, or
• by dragging the display with the mouse. 

Pan tool The Pan tool will let you move the view by a percentage of the 
visible display. You can set the amount that the view will move 
in the Pan Factor field on the General tab of the Tools > Options 
dialog box. (See “GENERAL” ON PAGE 93.) 
To move the view of data with the Pan tool: 
1. Select a Pan command:

• Pan Up: Re-centre the display at a position that is above the current 
display area.

• Pan Down: Re-centre the display at a position that is below the 
current display area.

• Pan Left: Re-centre the display at a position to the left of the current 
display area. 

• Pan Right: Re-centre the display at a position to the right of the 
current display area.

The Pan commands on the View menu can be added as buttons 
to a new or existing Toolbar by using the View > Toolbars > 
Customize… command. 

Pan with the mouse You can pan the display with your mouse by using a press and 
drag action. 
To pan with the mouse:
1. Press and hold down the scroll wheel or middle button on your mouse. 

(The cursor changes to a hand.)

2. Use the mouse to drag the view in any direction. 

3. Release the mouse button when you have repositioned the view.

M
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Zoom
There are two ways to magnify or reduce the viewing area in the 
Display window:
• use the scroll wheel on your mouse, if available
• use the Zoom tools

Zoom with the mouse To zoom in or out using a mouse: 
1. Click in the Display window. 

2. Scroll back and forth with the scroll wheel to zoom the view up and 
down.

Zoom tool Use the Zoom tool to select a specific area of the Display to 
enlarge: 
1. Select the Zoom command.

The cursor changes to a magnifying glass icon. 
2. Press and hold the mouse button and drag the cursor to create a 

rectangle around the area you want to magnify.

The display is enlarged so that the area within the rectangle 
now fills the Display window.
Once you enlarge the area, the Zoom tool button is no longer 
active. To keep the Zoom tool active, select the Enable Constant Zoom 
function in the Options dialog box (see “GENERAL” ON PAGE 93).

Zoom In
The Zoom In tool lets you enlarge the viewing area in the 
Display window automatically by a set amount.
1. Select the Zoom In command.

The display is automatically enlarged by the percentage set in 
the Zoom Factor field on the General tab of the Options dialog box 
(see “GENERAL” ON PAGE 93).

Zoom Out
Zoom Out automatically reduces the viewing area in the Display 
window by a set amount.
1. Select the Zoom Out command.

The display is automatically reduced by the percentage set in 
the Zoom Factor field on the General tab of the Options dialog box 
(see “GENERAL” ON PAGE 93).
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Zoom/Pan Previous
This tool returns the view to the position or magnification that 
was displayed before you zoomed or panned the view. 
1. Select the Zoom/Pan Previous command.

Zoom/Pan Forward
This tool returns the view to the position or magnification that it 
was in prior to using the Zoom/Pan Previous command.
1. Select the Zoom/Pan Forward command.

Zoom To
Re-centre the view on specific coordinates in the Display 
window, or zoom in so that the viewed area is displayed at a 
specific scale. 
1. Select the Zoom To command to display the Zoom To dialog box.

2. Type the new coordinates in their respective fields to re-centre on that 
point in of the Display window, 

OR 
3. Type a new scale to zoom into or out of the display.

4. Click OK.
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Refresh Display
Redraw the view in the Display window.
1. Select the Refresh command, or 

2. Click the middle mouse button when the cursor is in the Display 
window. 

The display is redrawn.

Overview Display
Redraw the Display window to the full extent of all the data that 
is currently open. 
1. Select the Overview command.

Cancel Draw
Select the Cancel Draw command from the View menu to stop a 
display from being drawn in the Display window. This command 
is only active while the image is being drawn. 
You can create a Cancel Draw tool button and place it on a new 
or existing Toolbar by using View > Toolbars > Customize… 
command.

Screen Captures
You can take a screen capture of the current display in the 
Display window or 3D Display window and save it as an 8-bit or 
24-bit GeoTiff image.
1. Right-click in the Display window or 3D Display window and select a 

Save Image command.

The Save As dialog box is displayed.
2. Select a directory and type a name for the image in the File Name field.

3. Select to either save the image as an 8-bit or 24-bit image by selecting 
the appropriate option.

4. Select a Sizing Parameter (either dots per inch or resolution) from the 
drop-down list.

5. Click Save to save the image to the selected directory.
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Save, Close and Exit

Save Projects 
Save changes to data after cleaning or when the display in a 
session file is changed. 
1. Select the Save command.

You can automatically save data-cleaning changes at regular 
intervals by selecting the Auto Save option (see “GENERAL” ON 
PAGE 93). 

Close a Project
1. Select the Close Project command.

You are prompted to save any changes.
2. Click OK to save changes.

Close individual track lines
1. Select a track line file in the Project tab of the Control window, or select 

a track line in the Display window.

2. Right-click the mouse and select the Close Lines command.

The track line closes.

Exit HIPS and SIPS
1. Choose the Exit command.

2. You may be prompted to save any changes.

3. Click OK.

HIPS and SIPS is closed.
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2
Display Background Data

Geo-referenced TIFF files and other formats can be opened as backdrop 
to the Display window. S-57 files can also be opened in the HIPS 
interface.

In this chapter...
OPEN BACKGROUND DATA ............................................ 46
IMAGE PROPERTIES ...................................................... 49
VIEW SOUNDINGS IN HOB FILE....................................... 51
OPEN URL ................................................................ 52
DISPLAY S-57 DATA .................................................... 53
CREATE LAYERS OF S-57 OBJECTS ................................ 54
CREATE LAYERS WITH THE RULE WIZARD ........................ 59
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Open Background Data
HIPS and SIPS can open any of the following data types as 
background in the Display window:
• AutoCAD files (DXF, DWG)
• BSB images (KAP)
• Bitmap images (BMP)
• CARIS files (DES, SAF)
• ECW images
• GeoTIFF (TIF) 
• GML (Geography Markup Language)
• HCRF images (CHR)
• HIPS Field Sheet (FSH)
• HIPS and SIPS Project (HIPS, HPF)
• Hydrographic Object Binary (HOB) files (including Edit and 

Marker layers created in CARIS Notebook).
• IGA images
• JPEG 2000 images (JP2)
• MrSid image files (SID)1 
• NetCDF (NC)
• S-57 files (000)
• Shapefile files (SHP)
• sound velocity profile files (SVP)
• tide zone files (ZDF)VPF database files (DHT)
• TFW images (TFW)
Surface formats that can be opened as background data include : 
• BIN files, including the NGS GEOID, European Gravimetric 

Geoid/QuasiGeoid (EGG97 and EGG2008) and German 
Combined QuasiGeoid

• CSAR
• ESRI ASCII and binary grid formats 
• HNS, IGA, MTS, HCS, DEF, BMS
• Datum model files (“OPEN DATUM MODEL FILE” ON PAGE 47)

1. MrSID image files can only be opened if you have installed the CARIS plug-in for MrSID 
images. This free plug-in can be downloaded from 
http://www.caris.com/downloads/mrsid.cfm.
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To open files in any of these formats: 
 1. Select the Open Background Data command.

The Open dialog box is displayed. 
Multiple instances of various types of supported files can be 
opened at the same time if they are located in the same folder.
2. Select one or more files within a folder. 

3. [Optional] Use the Files of type drop-down list to filter selection choice to 
files of a specific type. 

4. Click Open.

The selected files are opened in the Display window and are 
listed as layers in the Control window.

Open Datum model file To open a datum model file as background:
1. Select the Open Background Data command.

2. Select an XYZ file (must have the .xyz extension) and click Open.

This opens a dialog box so you can select a format description 
(*.info) file, used to parse the information from the XYZ file. See 
“INFO FILE” ON PAGE 160 for an example and description of this file.
3. Select the .info file that describes the format of the selected.xyz file. 

4. Click Open.

5. This opens the Select Projection dialog box.

6. Select the Coordinate system that describes the position format in the 
*.xyz file . Click OK.

The model file is displayed as a TIN (triangulated terrain model) 
data in the Display window, using the default Rainbow colour 
map. 
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Use Coordinate System
You can apply the coordinate system used by a background layer 
to the view of the data in the Display window. 
1. Right-click on the open background layer. 

2. Select the Use Coordinate System command from the pop-up menu. 

3. Refresh the display.

The view of the data now reflects the coordinate system of the 
background layer instead of that defined in the project file. 
The following shows the change to the display when the 
coordinate system of an S-57 file, open as background, is applied 
to a project that had a different projection.
 

To restore the project coordinate system, 
1. Right-click on the project layer. 

2. Select the Use Coordinate System command from the pop-up menu.

3. Refresh the display.

Po
p-

up Use Coordinate 
System

Project data in Display window

View of project using coordinate system
of S-57 file (contours)
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Image Properties
Image files which can be opened as background layers (TIFF, 
TFW, raster images, etc.) display properties in the Properties 
window. To view the image properties: 
1. Select the image layer in the Layers tab of the Control window. 

The Properties window automatically lists the display options 
for the selected image layer. The General fields display read-
only data such as the location of the image file, and its 
dimensions. These fields vary with the type of 

The Display fields adjust transparency and masking for the 
background image. 
The Image Transparency field controls the transparency of the entire 
image: the higher the percentage value, the more transparent 
the image will appear. The default is 0, (no transparency).
2. To make the entire background image transparent, type a Transparency 

percentage. 

The Colour Map field controls the colour display of the image. The 
value (default) indicates that the image is displayed in its 
original colour mapping. You can apply another colour map by 
selecting it from the drop down list. 
The masking fields make a single colour transparent. This is 
useful if the image background is different from the colour of the 
Display window.
To mask a particular colour:
3. Set Mask Colour Enabled to True. 

4. Select the colour to be made transparent from the Mask Colour drop-
down list, and refresh the Display. 
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In the example below, the top image shows a GeoTiff with white 
background displayed in the Display window (which has its 
background set to Black). The bottom image shows how masking 
the white background colour makes it transparent. 

The image masks another colour, in this case, the yellow areas. 
(Only one colour can be masked at a time.)
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View soundings in HOB file
To display the soundings stored in a HOB file, you must first set 
the display options in the S-52 tab of the Tools > Options dialog 
box.
1. Open the Tools > Options dialog box and select the S-52 tab.

2. In the Display filters section, select “Base + Other” or “Standard + Other” 
from the Category drop-down list.

3. Select the Soundings check box.

4. Select the Open Background Data command.
 5. Browse to the HOB file where the soundings are stored.

6. Click Open. 

The HOB file layer is displayed in the Layers tab of the Control 
window, and the soundings are shown in the Display window.

M
en

u File > Open 
Background Data
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Open URL
Use this command to connect to a Web Map Service or ECW/
JPEG2000 image site.
To connect to a Web Map Service:
1. Select the Open URL command.

 The Connect to Web Map Server dialog is displayed. 
2. Type the URL of the server to which you wish to connect. 

3. Click OK.

To connect to a ECW/JPEG2000 image site:
1. Select the Open URL command.

 The Open ECW / JPEG 2000 URL dialog box is displayed. 
2. Type the URL of the site you wish to connect to.

3. Click OK.

M
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u File > Open URL > 
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Display S-57 Data
HIPS and SIPS is capable of displaying S-57 Ed 3.1 (ENC) and 
HOB (Hydrographic Object Binary) files. (For information on 
other data types that can be opened in HIPS and SIPS, see “OPEN 
BACKGROUND DATA” ON PAGE 46.)

To open S-57 Ed 3.1 (ENC) data files:
1. Select the Open Background Data command.

The Open dialog box is displayed. 
2. Select S-57Files (*.000) from the Files of type drop-down menu. 

3. Browse to the folder containing the S-57 dataset and select the file. 

4. Click Open.
5. From the Select Catalogue dialog box, select either S-57 ENC 3.1 or S-

57 USACE ENC IENC 4.0 from the Name list, whichever is appropriate 
to the ENC being opened. (The other fields on the dialog box are 
automatically filled.)

6. Click OK.

7. In the S-57 Update Options dialog box, click OK.

This will display the selected S-57 dataset in the Display 
window and list the file in the data tree in the Layers tab.

M
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u File > Open 
Background Data
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Create Layers of S-57 objects
You can determine which feature objects are shown in the 
Display window using the filtering function of the Create Layer 
command.
You can create a layer of all objects with the same attribute 
value, acronym, ID or type, or use the Rule Wizard to create 
customized layers. You can also automatically create layers for 
objects by their unique feature acronyms.
1. Right-click on the S-57 file in the Layers tab of the Control window.

2. Select the Create Layer command from the pop-up menu.

3. From the list, select an option to filter which objects will be displayed in 
a new layer.

Layers are created: 
• “BY ATTRIBUTE VALUE” ON PAGE 54

• “BY FEATURE ACRONYM” ON PAGE 55

• “BY FEATURE OBJECT ID (FOID)” ON PAGE 56

• “BY FEATURE TYPE” ON PAGE 57

• “BY UNIQUE FEATURE ACRONYMS” ON PAGE 57

• “CREATE LAYERS WITH THE RULE WIZARD” ON PAGE 59

By Attribute Value
 

The options in the Operator and Value fields are determined by the 
selected attribute. For example, if an attribute requires a 
numeric value, a list with numeric values associated with the 
attribute will drop down from the Value field. If the attribute 
requires text, an area for typing text is opened from the Value 
field. 
1. Select an attribute from the drop-down list.

2. Select an operator from the list. The choice of operators is determined 
by the selected attribute.

3. Select an attribute value from the Value field. (The field only displays 
values related to the selected attribute.)

Po
p-

up Create Layer

Some of the dialog boxes in this process contain an Exclusive 
option. This option reverses the selection process by 
excluding the chosen features from the layer. For example, if 
you select a Point feature type and select the Exclusive option, 
all feature types except the point type are selected.
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4. Type a name for the layer in the Layer Name field, or automatically 
create a name from the above three fields by clicking the mouse once 
within the Layer Name field.

5. Click OK.

A layer will be created containing the objects with the attribute 
values that meet the search criterion. The new layer will be 
listed in the Layers tab data tree under the name of the S-57 file.

By Feature Acronym

1. Select one or more feature acronyms. Use any of three methods: 



56 CARIS HIPS and SIPS Reference

Display Background Data: Create Layers of S-57 objects

• Click a Feature Acronym cell and select a feature acronym from the 
drop-down list. 

• Type the feature acronym in the field using capital letters.
• Add feature acronyms to the clipboard (using the cut or copy 

commands) from another application, such as Notepad and select 
From Clipboard from the Import drop-down list.

2. Click the Exclusive check box to select all BUT the chosen feature 
acronyms.

3. Click OK.

A layer will be created containing all objects with the same 
feature acronyms. The new layer will be listed in the Layers tab 
data tree under the name of the S-57 file.

By Feature Object ID (FOID)

1. Type the Feature Object ID in the fields provided. (You can enter more 
than one ID.) 

OR copy the FOID to the clipboard using an application such as 
Notepad, click Import and select From Clipboard from the drop-down 
list.

2. Click the Exclusive check box to select all BUT the chosen FOIDs.

3. Click OK.

A layer will be created containing all objects with the same 
FOIDs. 
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By Feature Type
 

1. Click the check boxes of the primitive feature type(s) (point, line, area 
or sounding) you want to include in the layer.

2. Click the Exclusive check box to select all BUT the checked feature 
types.

3. Click OK.

A layer will be created containing all objects of the same type(s). 
The new layer will be listed in the Layers tab data tree under 
the name of the S-57 file.

By Unique Feature Acronyms
This option will automatically create a layer for each unique 
feature acronym represented in the open S-57 file. An example of 
these layers is displayed below. 



58 CARIS HIPS and SIPS Reference

Display Background Data: Create Layers of S-57 objects



CARIS HIPS and SIPS Reference 59

Display Background Data: Create Layers with the Rule Wizard

Create Layers with the Rule Wizard
The Rule Wizard command will create a layer containing objects 
using rules for complex filtering. Each rule is defined by one or 
more conditions, such as, “select only certain object types with 
specific attribute values”. 
Rules are saved as CRFX files in XML format, which you can re-
open in another dataset. You can also modify a saved filtering 
rule.

1. Click Add to create a new set of rules. 

Or 
1. Click Import to locate and open an existing rule (*.crfx) file so that it 

can be applied immediately or modified. See “IMPORT” ON PAGE 63.

Create new rule The first dialog box is displayed. 
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2. Select Create a new rule. 

This opens the next dialog box.
 

In the top section of the dialog box you can choose to include or 
exclude objects that match the conditions you are setting.
3. Select the Include objects check box to set the rule to include certain 

objects, or select Exclude objects to select all but those objects.

The selected option is displayed in the bottom section of the 
dialog box.
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4. Click Next.

Use this dialog box to set the specifics for the create layer rule.

5. Select the conditions that you want to use for creating the filter.

When a condition is selected, it is added to the rule description 
in the bottom part of the dialog box.
6. Click on one of the underlined condition names to select the 

appropriate acronym, feature type or value from the dialog box that is 
then displayed.

 

7. Click the underlined “and” to change the conditional operator. The AND 
operator includes features that meet both conditions. The OR operator 
will include features with either of the conditions.

Click here to open link.

Click here to open 
dialog box.
Click arrow to 
display the drop-
down list.
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The rule content is updated to the condition values you have 
selected. 
8. Click Next.

The next dialog box asks you to name your rule so it can be 
saved. 
 

9. Type a name for the rule.

10.Click Finish.

The rule is displayed in the main Rule Wizard dialog box. 

Rule Wizard Options
You can choose to import previously created rules, instead of 
creating a new rule. As well, you can modify and export rules. 
You can change the order in which filtering rules are applied. To 
access these options, use the buttons on the right side of the 
Wizard. 

Button Function

Add Create a new set of rules

Modify  Open the Rule Wizard to change settings

Remove  Permanently delete a filter rule from the layer.

Import Import an existing CRFX file into the Rule Wizard so it can 
be used or modified.

Export  Save the rule for future re-use, as a *.crfx file.
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Import Import an existing CRFX file into the main Rule Wizard dialog 
box so that it can be used or modified.
1. Click Import.

The standard Open dialog box is displayed.
2. Select the CRFX file and click Open.

Modify Change rule properties (such as adding or removing conditions) 
in an existing rule: 
1. Select the rule to modify.

2. Click the Modify button.

The Rule Wizard dialog box displays the information about the 
selected rule.
3. Use the steps in the wizard make changes to the filter rule. See “CREATE 

NEW RULE” ON PAGE 59.

Export Rules can be saved in XML format and re-opened to create 
layers in other datasets. Rules are saved as CRFX files and can 
be viewed in a text editor or XML-compliant Internet browser.
1. [Optional] Select a rule and click Export to select a file path and name 

for the CRFX file.

Rule Order To change the order in which rules are applied to create the 
selection:
Select a rule, and drag it to a new location in the list, then release the 
mouse button. 
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3
3D Display
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3D Display Window
The 3D Display window shows project-level information in three 
dimensions. Any data layers that are viewable in the HIPS and 
SIPS Display window can be viewed in 3D. This includes 
attribute layers for BASE Surfaces, vector data and background 
images such as GeoTiffs. 
The 3D Display is enhanced with a “fly-through” effect that gives 
the effect of gliding through the display. With practice 
manipulating the fly-through controls, you will be able to zoom 
and pan seamlessly in this 3D window. This fly through can also 
be recorded.(See “3D FLIGHT PATH” ON PAGE 86.)
To activate the 3D Display window 
1. Select the 3D Display command or tool button.

The 3D Display occupies the area of the Display window, and the 
3D tab replaces the Draw Order tab.
When first opened, the 3D window is empty of data. You display 
data by turning layers on and off in the Layers tab.
To display data:
2. Select a layer in the Layers tab.

Any layers that can be viewed in 3D are enabled in the Layers 
tab. Any open layers that cannot be displayed are disabled 
(greyed out) in the Layers tab, as in the image below.
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The following image shows a Depth layer opened in the 3D 
window.
 

Hover your mouse over the data to display a tool tip giving the 
name of the data source and the value at the current position of 
the cursor. 
The value is expressed in the units used by the selected layer. In 
the image above of a Depth layer, the tool tip displays 
“DredB7S” (the surface name) and “Depth(m) =X”(the depth 
under the cursor.
The coordinates of the current cursor location are displayed in 
the HIPS Status bar (on the right). Also displayed in the status 
bar is the “height” of the flight above the surface.

Tools panel 

Control axes (compass)

Colour legend

Controller panel 

Tool tip 
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3D Scene tab
The 3D Scene tab in the Control window lists the various types 
of data that are currently open in the 3D window.

Each type of data displayed in the 3D Display has its own layer 
in the 3D Scene tab.
• The Grid layer contains data for the surface being displayed.
• The Draped Images layer contains the data for all draped 

images.
• The Axes layer contains the Terrain Axes for the surface. The 

Terrain Axes (displayed as an x,y,z grid) are only visible when 
turned on in Tools > Options.(See “3D DISPLAY” ON PAGE 97.) 

• The Vector Data layer contains any vector data.
• The Image layer contains data for open raster images.

Display Options
Display options are set in the Display tab of the Tools > Options 
dialog box.
1. Select Options from the Tools menu.

2. Select 3D from the Display tab.

Use the options to turn on and off the display of:
• the Terrain Axes (x,y,z) grid for the selected surface (see “TERRAIN 

AXES” ON PAGE 79.) 
• the Colour Legend to indicate depths of the surface coloured 

areas 
• the Controller Panel 

• the 3D View Toolbar (Toolbar commands can also be activated 
from the View > 3D Flight Path submenu)

M
en

u Tools > Options > 
Display > 3D 
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• the colour to use as the Background Colour of the display 
• the View Style of the 3D window, for example, the default is Full 

View (the 3D window occupies the entire Display window). 
The other options include Vertical or Horizontal Tile, and 
Cascade.  

View Background Images
If you have background images to accompany the surface data, 
they can also be viewed in the 3D Display.
1. In the Layers tab, click the image layer check box to enable the image.

2. The Image Options dialog box is displayed.

The Elevation field allows you to specify the height at which the 
image sits on the surface.
3. Type a value if you would like the image displayed at a particular 

elevation.

The Clip to terrain option allows you to display only the part of the 
image that is within the extents of the surface.
4. Select the Clip to terrain check box to limit the display of the image.

The image is added to the 3D Display, and listed in the 3D Scene 
tab.

If the 3D View is open when these options are changed, the new 
settings do not take effect until the 3D view is closed and 
reopened.
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3D Display Window Properties
The display in the 3D View can be adjusted using properties. 
If you have data visible in both the 3D Display and the Display 
window, switching back and forth from one window to the other 
will display different properties. A layer must be activated 
(check box selected) and selected (highlighted) to enable 
properties to be set in 3D.
The following sections provide information on the 3D properties:
• “SURFACE DATA PROPERTIES” ON PAGE 70

• “VECTOR DATA PROPERTIES” ON PAGE 71

• “RASTER DATA PROPERTIES” ON PAGE 73

Surface Data Properties
1. Select an attribute layer, for example, Depth, in the Layers tab to view 

the available properties of that layer in the Properties window. 

General The Visible property allows you to have the data open and 
included in calculations, without actually having it displayed. 
This frees up resources to speed up processing time. By default 
this option is set to True.
1. [Optional] Set the Visible property to False to hide the selected image. 

The Quality property allows you to display the surface using a 
finer or coarser resolution. The default setting is Normal.
2. Select the Quality property and select an option from the drop-down list
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Appearance The Appearance property controls the colour of your 3D surface. 
You can display the surface using a colour map or using a solid 
colour. By default the display is set to Colour Map.
3. [Optional] Change the display by selecting Solid Colour from the drop-

down list and selecting the colour from the colour picker.

Filter properties The Filter properties can be used to filter data displayed in 3D.
4. Enable the FIlter property by clicking the check box. 

The value will change to True.
5. Enter the Min and Max Value of the data you want displayed.

6. Refresh the display.

Only data that falls within the range of the Min and Max values 
will be displayed.

Colour properties Colour properties enable you to adjust the colour range used to 
colour the displayed data. (See also “COLOUR RANGE” ON PAGE 77.) 
7. Enter the Min and Max Values to be covered by the colour range.

Using the Colour By property, you can choose which attribute will 
be used as the source data for colouring the display.
8. Select an option from the Colour By drop-down list.

The display is updated to match the selected properties.

Vector Data Properties
To display the 3D display properties for vector data:
1. Select a vector data layer in the Layers tab while the 3D Display is 

active. 

2. Open the Properties window.

The Visible property allows you to have the data open and 
included in calculations, without using resources to actually 
have it displayed. By default this option is set to True.
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3. Click the Visible check box to display the selected image, if necessary.

When visible, you have the option of draping data over the 
surface, so you can accurately view contours and other vector 
data.
4. Expand the Drape property and in the Method field, select one of the 

following three options:

• None: Data is displayed according to the Default Elevation 
property. With this option, all vector data will be on a level 
plane unless the data contains its own Z value. The Elevation 
defines the height at which the data sits above the surface. 
(The other Draping properties are disabled when None is 
selected as the method.)Drape: Data is draped using the 
bathymetry of the surface and the Offset property. The 
bathymetry will apply the proper Z value to the data and the 
Offset will define the height at which it sits above the surface.

• Drape (use line splitting): Data is draped using the same 
values as the Drape method, but line segments are adjusted 
in length based on the Max segment length property. A larger 
segment length means less vertices and faster processing 
times. A smaller segment length means more vertices and 
slower processing times, but a more accurate representation 
of the elevations. (The Max segment length property is only 
enabled when the Drape (use line splitting) method is 
selected.)

5. Choose an option from the drop-down list.

6. Depending on the selected method, enter any necessary values in the 
other properties. 

The image is draped over the surface.The example below shows 
a GeoReferenced TIFF draped over data. 
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7. [Optional] If the image extends beyond the extents of the data, select 
the Clip to terrain check box to only show the section of the image within 
the surface extents.

You can also perform the opposite of the drape function where 
the image is cut away according to the bounding polygon of the 
surface. This allows you to view a background chart image with 
the actual surface visible within the chart.
To cut away the image:
8. In the Layers tab, right-click the image layer, select Cut Terrain, then 

select the name of the surface with which you want to cut the image.
The image is cut and the gap is filled with the surface, as in the 
example below.

Raster Data Properties
To display the 3D display properties of raster data:

1. Select a raster data layer in the Layers tab while the 3D Display is 
active 

2. Open the Properties window. 

Data that extends beyond the extents of the surface will be 
displayed according the Default Elevation value, regardless 
of the selected method.
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The Visible property allows you to have the data open and 
included in calculations, without using resources to actually 
have it displayed. This option is set to “True” by default.
3. Click the Visible check box to display the selected image.

The Vertical Position property allows you to adjust the elevation of 
the image in the display so that it lines up with the surface 
properly.
4. [Optional] Enter a value in the Vertical Position field.

The Transparency property allows you to make the image 
transparent so the surface can be seen in relation to the image.
5. [Optional] Enter a value in the Transparency field.

The display is updated to match the selected properties.
Draping Raster Data Raster images can also be draped over a surface using the 

bathymetry of the surface. 
To drape a raster image:
1. Open a raster image.

2. Select the attribute layer in the Layers tab that you want to use to 
define the draping elevation.

3. Right-click the attribute layer, then select Drape Image and then the 
name of the raster image to be draped.

The image is draped over the surface and a sub-layer is added to 
the Layers tab for the draped image.
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Adjusting the Display
In addition to defining properties, there are various tools within 
the 3D Display that can also be used to adjust the display of 
data, such as:
• “LIGHTING” ON PAGE 75

• “VERTICAL EXAGGERATION” ON PAGE 76

• “COLOUR RANGE” ON PAGE 77

• “CONTROL AXES” ON PAGE 78to rotate the data.
•

Lighting
The lighting control handles shading effects by controlling the 
position and angle of the light. The elevation value (displayed 
when the tool is selected) varies from 0º to 90º starting from the 
middle of a sundial. The azimuth value (also displayed when 
selected) varies from 0º to 360º in a clockwise direction.  
To turn on the Lighting Control:
1. Pass cursor over the Light Control button in the Tools panel located in 

the top-left corner of the 3D Display.

The Lighting tool displays the current azimuth and elevation 
values.

2. Click and drag the ball to change the lighting.

As you drag, the values in the tool will be updated and you can 
see the affect on the data.
3. Release the mouse when the display has the proper lighting.

4. To close the tool, click the X in the top-right corner of the box.

5. To re-open the lighting tool, click the light bulb.

Click and drag 
the ball to change 
the lighting.

Hover to to view 
Lighting tool. Off.............On
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Vertical Exaggeration
Use the Vertical Exaggeration tool to increase or decrease the 
vertical exaggeration of the data to display seabed features more 
clearly. 
To access the Vertical Exaggeration tool,
1. Hover the cursor over the middle button in the Tools panel (located in 

the top-left corner of the 3D Display).

The tool activates and a slider bar is displayed below the Tools 
panel.

2. Click the arrow on the side of the slider and move it up or down the bar.

As you move the arrow, note the change in the display.
3. Release the arrow when the data has the appropriate vertical 

exaggeration.

4. To close the tool, click the X in the top-right corner of the box.

Move up or down to adjust exaggeration.

Vertical exaggeration tool.

Click to close tool. 
ON..........OFF
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Colour Range
The colour legend slider bar located along the right 
side of the 3D Display adjusts the colour range. The 
arrows on the side of the legend represent the Min 
and Max Values of the colour range.
To display the colour legend:
1. Click the Colour Range control.

To change the colour range using the colour legend: 
1. Select the control arrow at the top or bottom of the 

legend.

2. Drag the control to the desired Min or Max value.

The colours in the display will change as you drag 
the arrow.
3. To reverse the colours, drag one control past the other. 

The legend can be turned on or off using the Colour 
Legend button in the top-right corner of the 3D 
View. When the button is coloured, the legend is turned on and 
available for use.  

, 
Off.............On
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Control Axes
You can manipulate the view along the XYZ axes with the 
Control axes. Sometimes called compass controls, these are 
displayed as an overlay to the surface. 
1. While pressing the middle mouse button, click on the surface in the 

Display.

The control axes appear. They are centred on the point at which 
you clicked the surface.

If you continue to press the middle mouse button you can tilt the 
display in three dimensions. 
 

Rotate horizontally Rotate vertically
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Terrain Axes
The terrain axes make up an XYZ grid that can be turned on in 
the 3D Display window. This grid runs parallell to the control 
axes. Whereas the control axes are only visible while being used 
to rotate data, the terrain axes remain visible until turned off. 
To turn on the terrain axes:
1. Select Options from the Tools menu.

2. Select 3D from the Display tab.

3. Select the Terrain Axes check box to make them visible.
 

M
en

u Tools > Options > 
Display > 3D 

Terrain axes Control axes



80 CARIS HIPS and SIPS Reference

3D Display: Navigate the 3D Display

Navigate the 3D Display
You can use Zoom commands to zoom in and out, or you can 
zoom to the extent of the selected layer.
To zoom to the extent:
1. Right-click on a layer in the Layers tab.

2. Select Zoom to Map from the pop-up menu.

You can also use the zoom and pan functions of the Controller 
panel, the mouse or the keyboard to create the effect of flying 
over the display.
• To “fly” using the Controller, manipulate the controls in the 

CONTROLLERpanel. 
• To fly using the mouse, press and hold one or both of the 

mouse buttons while simultaneously moving the cursor. See 
“MOUSE AND KEYBOARD CONTROLS” ON PAGE 81

• To fly using the keyboard, use the <Arrow> keys or keyboard 
shortcuts. The speed you travel through the display or pan 
the view varies with the cursor’s distance from the centre 
(stationary) point. See “MOUSE AND KEYBOARD CONTROLS” ON PAGE 81

• You can also zoom into the display using the “NAVIGATION ICON” ON 
PAGE 84.

These controls can be used while recording the fly-through.

Controller
The Controller panel consists of a directional pad and slider 
controls used to modify the view and perform a fly-through.
The Controller panel can be turned on or off using the Controller 
Panel button in the top-right corner of the 3D View. When the 
button is coloured, the panel is turned on and available for use. 
When turned on but not in use, the panel becomes transparent 
so as not to obstruct the view of the data.

To
ol

, 
Off ............ On
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The Controller panel contains the following controls:

Mouse and keyboard controls
When navigating with a mouse you can use the left and right 
buttons as well as the scroll wheel. Certain keys control these 
same movements. 
With both mouse and key controls, the position of the cursor in 
the display determines the direction in which the image moves. 
When you click in the window, the data moves away from the 
cursor.
For example, when you click with the left mouse button, the data 
will move to the left or the right, depending on where the cursor 
is in relation to the data. When you click with the right mouse 
button, the data moves up or down.
Note that the mouse controls differ according to the Controller Type 
set in Tools > Options > 3D: 
• If the Controller Type is set to Terrain Flyer, the controls allow 

you to navigate from the perspective of the height source. See 
“NAVIGATING AS TERRAIN FLYER” ON PAGE 82.

• If set to First Person, the controls navigate from a camera 
view of the current 3D scene. See “NAVIGATING AS FIRST PERSON 
CONTROL” ON PAGE 82.

See “MOUSE/KEYBOARD CONTROLLER OPTIONS” ON PAGE 85.

Pan left

Change 
viewing 
height:
up (“+”)/
down (“-”)

Steer view (clockwise 
from the top: forward, 
rotate right, reverse, 
rotate left)

Tilt viewing angle: forward (“-”) / back (”+”)

Move backward 
(reverse)

Move forward

Pan right

Compass direction 
(North)
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Navigation tools
The following tables list the keyboard and mouse controls for 
viewing and navigating the display. 

Navigating as Terrain flyer 

Navigating as First Person Control

Action

Mouse Control

KeyMove cursor Press button

Pan backward in a straight line, horizontal to the TERRAIN AXES 
(PAGE 79)

Down Right Shift +S

Pan forward in a straight line, horizontal to the TERRAIN AXES (PAGE 
79)

Up Left Shift +W

Pan left in a straight line, horizontal to the TERRAIN AXES (PAGE 79) Left Left+right Shift + A

Pan right in a straight line, horizontal to the TERRAIN AXES (PAGE 
79)

Right Left+right Shift + D

Pan up in a straight line, vertical to the TERRAIN AXES (PAGE 79) Up Left+right Shift + R

Pan down in a straight line, vertical to the TERRAIN AXES (PAGE 79) Down Left+right Shift + F

Rotate left Left Left

Rotate right Right Left

Tilt back, viewing angle goes up Up Right

Tilt forward, viewing angle goes down Down Left

Action

Mouse Control

KeyMove cursor Press button

Pan backward in a straight line, horizontal to the . Down Right Shift + S

Pan forward in a straight line, horizontal to the TERRAIN AXES (PAGE 
79).

Up Right Shift + W

Pan left in a straight line, horizontal to the TERRAIN AXES (PAGE 79) Left Right Shift + A

Pan right in a straight line, horizontal to the TERRAIN AXES (PAGE 79) Right Right Shift + D

Pan up in a straight line, vertical to the TERRAIN AXES (PAGE 79). Up Left+Right Shift + R

Pan down in a straight line, vertical to the TERRAIN AXES (PAGE 79) Down Left+Right Shift + F

Rotate left. Left Left
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Common controls

Rotate right. Right Left

Tilt back, viewing angle goes up Up Left

Tilt forward, viewing angle goes down Down Left

Action

Mouse Control

KeyMove cursor Press button

Action

Mouse Control

KeyMove cursor Press button

Rotate and tilt around the x,y,z Control axes Any direction Middle --

Zoom in Wheel: Scroll forward Ctrl+ 

Zoom out Wheel: Scroll backward Ctrl+ 
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Navigation icon
You can also change the view by manipulating the navigation 
icon around the selected surface in the Display window. 
Movement of the icon in the Display will be reflected in the 3D 
View. 
To use this tool, 
3. Click on the arrow icon and drag your mouse in the direction you want 

to view. This drags out a dashed line. 
• When you release the mouse click, the icon will move in the 

direction of the arrow to the spot where you released it.
• In the 3D view the surface zoom in to follow path made by the 

dotted line in the Display. 

Position of icon in Display window View of surface in 3 D window

Icon has moved to end of dotted line

1

2

View is now zoomed closer to surface.
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Mouse/Keyboard Controller Options
In the Options dialog box, the 3D tab provides options for 
adjusting the settings of the keyboard and mouse controllers 
used to navigate the 3D Display. The following options are 
available:
• Controller Type: Select one of two types of controls to use 

when navigating the 3D Display:
• Terrain Flyer: allows you to navigate from the perspective 

of the height source.
• First Person: allows you to navigate from a camera view of 

the current 3D scene. 
• Flight Speed: Controls the speed at which you move through 

the display during a fly-through. Move the slider bar left or 
right to increase or decrease flying speed.

• Zoom Speed: Controls how fast the view is changed when 
using the zoom controls. Move the slider bar left or right to 
increase or decrease zooming speed.

• Smooth-Fly-To Speed: Controls how fast the view is changed 
when you double-click an area of the 3D View. Move the slider 
bar left or right to increase or decrease zooming speed.
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3D Flight Path
You can make and save movies of a 3D fly-through for playback 
at a later time. The controls for creation and playback are 
located in the 3D Display Tools panel and the 3D Flight Path 
submenu. 

Instructions for using these tools are provided in the following 
sections:
• “RECORD A FLIGHT” ON PAGE 86

• “PLAY A FLIGHT” ON PAGE 87

• “LOAD AN EXISTING FLIGHT” ON PAGE 87

• “SAVE A FLIGHT” ON PAGE 87

• “EXPORT A FLIGHT TO VIDEO” ON PAGE 88

Record a Flight
To record a fly-through:
1. Select a layer in the Layers tab to display in the 3D Display.

2. Adjust the view to display the starting point for your fly-through.

3. Select the Record command.

The Record button will change to red to indicate that you are 
now recording.
4. Use the controls to navigate your flight path through the 3D Display. 

See “NAVIGATE THE 3D DISPLAY” ON PAGE 80 for information on navigating. 

All movements in the Display window are recorded.
5. To stop recording, select the Record command again or select the 

Stop command.

The Record button will return to the inactive state and your 
fly-through is recorded and ready for playback.

RecordPause
Play

M
en

u View > 3D Flight Path 
> Record

To
ol

M
en

u View > 3D Flight Path 
> Stop
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Play a Flight
To playback a recorded fly-through:
1. Select the Play command.

The fly-through will begin to play. As it does so, the arrow on the 
slider bar will move from left to right and the counter at the end 
of the slider bar will count down, indicating the progress of the 
fly-through. The slider bar can also be used to go forward or 
backward in the recording.
2. [Optional] Click the arrow on the slider bar and drag it to the left or right 

to go forward or backward in the recording.

You can pause the playback if necessary without stopping it 
altogether.
3. [Optional] Select the Pause command to pause the playback.

The Pause button will be coloured to indicate that playback has 
been paused. Both the Pause and Play commands can be used to 
resume playback after the Pause command has been selected.
4. To stop the playback, either select the Play command again, or select 

the Stop command. 

Otherwise, playback stops when you reach the end of the 
recording.

Load an Existing Flight
If you have saved a fly-through to a file, that file can be loaded 
and played in the 3D View at anytime.
To load an existing flight:
1. Open the 3D Display.

2. Select the Load from File command.

A standard Windows Open dialog box is displayed. 
3. Navigate to the flight file and click Open.

The fly-through is loaded into the 3D Display and the flight path 
controls are available.

Save a Flight
Once you have finished recording a fly-through, you can save it 
to an XML file that can be viewed in HIPS and SIPS at any time. 
To save a flight to an XML file:
1. Record the fly-through.

M
en

u View > 3D Flight Path 
> Play

To
ol

M
en

u View > 3D Flight Path 
> Pause

To
ol

 .... 

M
en

u View > 3D Flight Path 
> Stop

M
en

u View > 3D Flight Path 
> Load from File
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2. Select the Save to File command.

A standard Windows Save As dialog box is displayed. 
3. Select a location for the file and enter a File name.

4. Click Save.

The flight is saved as an XML file in the selected location with 
the specified name.

Export a Flight to Video 
 If you do not export your recording, it can only be re-opened in 
HIPS and SIPS, but an exported recording can be opened in any 
standard media player. 
To export a record of your fly-through:
1. Open or create a fly-through.

2. Select the Export to Video command.

The Record Movie dialog box is displayed.

3. Choose the format of the video file. If you selected AVI format, go to 
step 6. If you selected WMV format, continue with the next step.

You may select a bitrate for the recorded data as a variable or a 
constant value. 
• Variable Bitrate records the video using a fluctuating bitrate, 

which is based on a user-defined average quality level. 
During encoding, the bitrate will fluctuate to ensure the video 
is created with the highest possible quality while maintaining 
the specified average.

M
en

u View > 3D Flight Path 
> Save to File

M
en

u View > 3D Flight Path 
> Export to Video
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• Constant Bitrate records the video using a user-defined 
number of kilo-bits per second. This option ensures that a 
constant bitrate is used during encoding, but may result in a 
lower quality video. 

4. Select a bitrate option.

5. If you selected Variable Bitrate, enter the average quality level for the 
resulting video and go to step 7.

OR

If you selected Constant Bitrate, enter the number of kilo-bits per 
second to use to record the video and go to step 7.

6. [Optional] To see the advanced playback options for your AVI movie 
before it is saved, select the Show Advanced Options option.

You must select image size and FPS (Frames-Per-Second) options 
for the playback of your movie.
7. Select a Size option.

8. Select an FPS option.

9. To select the save name and location for your movie file, click the 
Browse button (...).

A Save As dialog box is displayed.
10.Type a save name.

11.Select a save folder.

12.Click Save.

The Save As dialog box is closed, returning you to the Record 
Movie dialog box.
13.If you clicked the WMV format option, click Save and go to step 19;

OR,

if you clicked the AVI format option, click Save and continue with the 
next step.

Video Compression The Video Compression dialog box is displayed.
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14.Select a Compressor.

15.Use the slider control to select the compression quality (displayed as a 
value in the range of 0 and 100 percent).

16.[Optional] To insert key frames, select the Key Frame option and type a 
frames value.

17.[Optional] To set the data rate, select the Data Rate option and type a 
KB/sec (kilobits per second) value.

With some compressors, you can also choose the configuration 
settings to use for your AVI movie.
18.[Optional] To configure the selected compressor, click Configure and 

select from the available configuration options.

19.Click OK.

A message is displayed stating that the file was saved.
20.To finish, click OK.

The process is finished. 

Some video compressors do not allow you to set the 
following options (in steps 15 to 17) for your movie files.



4
 Options

HIPS and SIPS options control the layout and appearance of the HIPS 
and SIPS interface, as well as the access to data repositories and files on 
a network.
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Introduction
The Options dialog box has a number of parameters to help you 
control the appearance of the interface, the behaviour of some 
commands, and the system environment.
1. Select the Options command.

The Options dialog box is displayed. The dialog box contains the 
following tabs:
•
2. Click Apply to implement the changes without closing the dialog box, 

or OK to implement the changes and close the dialog box.

M
en

u

Tools > Options
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General 
On the Options - General tab you can set parameters that 
determine how you want to work with data.

1. Set options as described in the table below.

 

Field Description To assign a value...

Zoom factor Set the percentage used to increase or 
decrease the display scale when using 
the Zoom functions.

Select a percentage rate for the zoom tool using 
the up or down arrows in the Zoom factor box.

Pan factor Set the percentage used to move up, 
down, left, or right while using the Pan 
tools.

Select a percentage by clicking the up or down 
arrow keys beside the Pan factor box.

Pick aperture The Pick Aperture determines the 
maximum distance (in pixels) that a 
cursor can be from an object to select 
it. For example, if the Pick Aperture is 
set to five, the cursor must be a 
distance of five pixels (or less) to select 
an object.

Select the pixel area for the Pick aperture by 
clicking the up and down arrow buttons.
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Sounding size Display sounding digits in a field sheet 
or tiled area at a selected size 
(millimetres at map scale).

Enter a sounding size value in the Sounding 
Size field.

Editor Outline 
Transparency

Control the transparency levels of fills 
for Swath, Side Scan and Subset 
Editor outlines in the Display window.

Select a percentage value for transparency (0 
equals no transparency, 100 equals total 
transparency) by clicking the up or down arrow 
buttons.

SVP location 
symbol

Select a feature code for the symbol 
that shows the location where SVP 
data was recorded.

Select a feature code from the drop-down list.

Navigation point 
symbol

Select a feature code for the symbol 
display of points in the Navigation 
Editor.

Select a feature code from the drop-down list.

Symbolize CARIS 
map

 When enabled, line weights and 
symbology map are applied based on  
CARIS master and symbol files.
When turned off, the lines are drawn as 
harilines with not symbology.

Check the Symbolize CARIS map box to 
implement this option for a background CARIS 
map.

Auto save Automatically save all status flag 
changes at set intervals.

Select the Auto Save check box to implement 
this function.

Enter the interval (in minutes) that work is to be 
saved.

Enable constant 
Zoom

Set the Zoom function to allow 
repeated Zoom commands until 
function is turned off. 

(Default is to switch to Selection 
function after one Zoom.)

Select the Enable constant Zoom check box to 
implement this option.

Automatic 
Recentre

Redraw the Display window so that the 
sounding coverage outline is always 
displayed in the centre when scrolling 
along the line.

Select the Automatic recentre check box.

Automatically 
update projects

When this option is set, HIPS/SIPS will 
check the UTM zone for all lines in a 
project every time the project is 
reopened. 

By default, Automatically update projects is 
NOT selected. This ensures that HIPS only 
searches for and sets the UTM zone when the 
project is first opened, (even if the project was 
created using the Select UTM zone automatically 
option).

Automatic refresh Refresh the Display window 
automatically when layers are turned 
on or off, or when the drawing order is 
changed in the Control window.

Make sure the Automatic refresh box is 
checked to implement this option.

Enable tool tip Show/hide the display of ToolTips when 
the cursor is over a BASE surface or 
toolbar button.

Make sure the Enable tool tip box is checked to 
implement this option.

Field Description To assign a value...
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2. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box. 

Automatic BASE 
Surface update

Automatically update BASE Surfaces 
changed due to cleaning sounding data 
in the Swath and Subset Editors, or 
after cleaning CUBE data in the Subset 
Editor.

Select checkbox activate the Automatic BASE 
Surface update.

Show line Display a diagonal line inside the 
bounding box that is drawn when 
selecting data.

Click the Show line check box.

Show distance Display the distance that the bounding 
box covers when it is drawn on the 
screen during selection.

Click the Show distance check box.

Field Description To assign a value...
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Display
 The Display tab lists various display controls for such items as 

fonts, visibility and position of labels, and so forth. 
Many of the colour options set in this tab indicate the status of 
displayed elements such as track lines (merged or not,) and 
critical soundings (designated, rejected, outstanding, etc.).

1. Select the Display tab.

The Options - Display dialog box is displayed.
2. Select an item from the Category list.

The controls for the selected editor or window are displayed on 
the right side of the window. These controls are described below. 

These colours can also be changed in the Properties for a layer, for 
example, for example, the colour of designated soundings can be 
changed in the Critical Soundings layer. However, these colour 
settings are not retained unless saved to a session file. 
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3D Display 

Use settings in Tools > Options > Display > 3D to:
• display a Terrain Axes (x,y,z) grid for the selected surface.
• turn on or off the display of the Colour Legend which 

indicates depths of the coloured areas in the display. 
• turn on or off the display of the Controller Panel. When 

turned off, the controller panel’s on/off button within the 3D 
View is also removed.

• display the 3D View Toolbar. If this option is not enabled, the 
commands can be activated from the View > 3D Flight Path 
submenu.

• select the colour to use as the Background Colour of the 3D 
View.

• View Style sets the manner in which the 3D window is 
displayed within the Display window area. 

If the 3D View is open when these options are changed, the new 
settings do not take effect until the 3D view is closed and 
reopened.
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• In Full View the 3D View occupies the entire Display 
window. 

• Vertical Tile (and Horizontal Tile) the 3D View is tiled 
vertically (or horizontally) with the Display window and 
any other open windows. 

• Cascade arranges all the open windows within the Display 
window so that they overlap one another, with their title 
bars visible.
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Contours
Use the Contours options to set the display of labels for contour 
lines created in a product surface.

Set:
• Size in mm of the contour label.
• Number of decimal places to the right of the decimal point to 

display in the label.
• Space in mm around the label when the masking option is 

used.
• Orientation of the label with respect to the contour line it is 

labelling.
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Display window
Set the display and colour features for the ship and towfish track 
lines.

1. Set the parameters described in the table below. 

Field Description To assign a value...

Display Window fields:

Background Control the background colour. Select a colour for the background from 
the colour palette, or create a custom 
colour from the standard Windows colour 
picker.

Show Side Scan Outline The side scan outline marks the extent of 
the data currently visible in the Side Scan 
Editor.

Select the Show Side Scan Outline 
check box to display the marker in the 
Display window while the Side Scan 
Editor is open.

Enable during playback Move the side scan outline along the track 
line during the Playback option in the Side 
Scan Editor.

Select the Enable During Playback 
check box to make this option active.
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2. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Show Swath Outline The swath outline marks the extent of the 
data currently visible in the Swath Editor.

Select the Show Swath Outline check 
box to display the marker in the Display 
window while the Swath Editor is open.

Measure Distance Select a font to display measurements 
when the Measure Distance command is 
used.

Click Font and select a type face, font 
size and colour from the dialog box.

Ship Track Lines fields:

Not Merged The colour for track lines that have not 
been merged into a position/depth file

Select a colour from the colour palette, 
or create a custom colour from the 
standard Windows colour picker.

Merged The colour of track lines that have been 
merged into a position/depth file.

Towfish Track Lines fields:

Raw Side Scan Only The colour used to display track lines 
when side scan data is still in raw mode.

Slant Range Corrected The colour used to display track lines 
when side scan data has been slant range 
corrected.

Use Multiple Colours This option uses a set of ten distinct 
colours to colour the track lines in the 
Display window. This is helpful if the 
survey data was logged as multiple files 
along the same runline.

Click the Use Multiple Colours check 
box to enable this option for ship track 
lines or towfish lines.

Field Description To assign a value...
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Geographic Grid
Options for the Geographic Grid control the display of a 
temporary grid based on geographic units, drawn over the extent 
of your project.
For a grid to cover the extent of a field sheet only, see “FIELD SHEET 
PROJECTION GRID” ON PAGE 178 of the Users Guide.

1. Select the Visible check box to display the grid in the Display window.

2. Set other display options as described below. 

Field Description To assign a value...

Labels:

Top/Left/ 

Bottom/Right

Display geographic coordinates at 
selected locations in the Display 
window 

Select the check boxes.

Colour Set a colour for the grid labels. Select a colour from the colour picker, or create a 
custom colour from the standard Windows colour 
palette.

Font Typeface and point size for grid labels Click the Font button to open the standard 
Windows Font dialog box to select a font type 
and size.
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3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Type The type of markings to make up the 
geographic grid.

Select a type from the drop-down list.

Length The length of the markings (mm at map 
scale).

Type the length.

Line Attribute 
Colour

Colour for the geographic grid 
markings.

Select a colour from the colour picker, or create a 
custom colour from the standard Windows colour 
palette.

Weight Thickness of the markings Type a value into the field.

Custom Spacing Set the distance between grid 
markings in the display.

Select the check box.

Latitude/Longitude Spacing of grid markers in minutes. Type a value in the provided field.

Field Description To assign a value...
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IHO Standards
The IHO Standards options control the colour options for the 
display of data according to International Hydrographic 
Organization (IHO) standards. Colours can be set for each S-44 
survey order and S-57 Zone of Confidence (CATZOC). The 
Unclassified option sets the colour for soundings that exceed the 
defined limits of the selected standard.

1. Select a colour from the appropriate colour palette, or create a custom 
colour from the custom colour box.
• IHO S-44: Colours for displaying soundings according to S-44 survey order. 

• IHO S-57: Colours for displaying soundings according to the S-57 
CATZOC zones of confidence attributes.

2. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

See also “TPU FILTERING” ON PAGE 155 of the User Guide.
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LIDAR
LIDAR options control the colour options for LIDAR data in the 
Swath and Subset Editors.

1. Select waveform colour from the appropriate colour palette, or create a 
custom colour from the colour picker. 
• Waveform: colour for displaying waveform data.
• Detected: colour for displaying soundings.
• Alternative: colour for displaying soundings with an alternative 

depth.

2. Select a colour for each of the LIDAR flags. 

3. Display or hide soundings with specific quality flag by selecting or 
clearing any of the quality flag check boxes.
• No Decision: soundings that have a detected and alternative depth. 

(Quality 1 flag).
• Kept Detected: soundings where the detected depth is retained over 

the alternative depth (Quality 2 flag).
• Swap to Alternative: soundings where the detected depth has been 

replaced by the alternative depth (Quality 3 flag).

4. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.
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Mosaic Editor
Set the colours for the display of backscatter trace in a Sediment 
Analysis graph in Mosaic Editor. 

• Total Backscatter (default colour blue) - combined backscatter from 
the three sources

• Interface Backscatter (default colour light green) - from the sea 
floor/water interface

• Volume Backscatter (default colour red) - from within the sediment
• Kirchhoff Backscatter (default colour yellow) - models the sea floor 

roughness.

See also “SEDIMENT ANALYSIS GRAPH” ON PAGE 451



CARIS HIPS and SIPS Reference 107

Options: Display
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Projected Grid
Projected Grid display options control visibility, labelling and 
appearance of a grid based on ground coordinates, projected over 
your entire project.
 

1. Select the Visible check box to display the grid in the Display window, 
and to activate the display options.

To change from default values:
2. Select any of the Labels check boxes to display coordinates at those 

selected locations in the Display window: Top/Left/Bottom/Right.

3. Click Colour to select a colour for the grid labels, from the colour 
picker, or create a custom colour.

4. Click Font to open the Windows Font dialog box to select a typeface 
and point size for grid labels.

5. From the Type drop-down list, select the type of markings to make up 
the projected grid, e.g., full lines, ticks and crosses.

6. Set the Length for the markings in mm at map scale.

7. Select a colour for the grid lines.

8. Type a Weight value for the thickness of the grid lines.

9. Set the distance between grid markings in the display, by selecting the 
Custom Spacing check box and typing a value into the Easting and 
Northing fields. (Spacing of markers in mm at map scale.)
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10.Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

To project a grid which covers the extent of a field sheet only, see 
“FIELD SHEET PROJECTION GRID” ON PAGE 178 of the Users Guide.
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Scale Bar 
This tab controls the options for the display of the scale bar.

1. To show a scale bar in the Display window, select the Visible check 
box.

To change from the default settings: 
2. Select the position of the scale bar in the window from the Location 

drop-down list. 

3. Select a Colour for the scale bar from the colour picker, or create a 
custom colour from the Windows colour palette.

4. Click Font to select the font type, style and size from the Font dialog 
box.

5. Select the Background Colour check box to turn on a colour for the 
scale bar. Change the colour by selecting from the colour picker.

6. To draw a border line around the scale bar, select the Draw Border 
check box. 
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Sensor Editors
The Tools >Options - Sensor Editors tab controls some of the 
colour settings for editors such as Attitude Editor adn 
Navigation Editor..

1. Set the parameters described in the table below. 

 

Field Description To assign a value...

Labels Labels display the horizontal and 
vertical scale lines and annotations in 
the editors. 

Show or hide labels (the labels are 
toggled to on when the Label box is 
checked).

Select a colour for the labels from the 
colour palette, or create a custom colour 
from the standard Windows colour 
selector.

Background Use this control to set the background 
colour in the editors.

Select a colour from the colour palette, 
or create a custom colour from the 
standard Windows colour selector.

Selected The colour for highlighted data in the 
Display window and in the editors.

Superselection Sets the colour for superselected data 
in the Swath and Subset Editors.
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2. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Moving Average Sets the colour for the Moving Average 
line in the Attitude and Single Beam 
Editors.

Select a colour from the colour palette, 
or create a custom colour from the 
standard Windows colour selector.

Difference Sets the colour for Difference line in the 
Attitude and Single Beam Editors.

Threshold Sets the colour for the Threshold line in 
the Attitude and Single Beam Editors.

Port Sets the colour for the port side of the 
side scan coverage outline in the Side 
Scan display, or the port soundings in 
the Plan View of Swath Editor. Select a colour from the colour palette, 

or create a custom colour from the 
standard Windows colour selector.

Starboard Sets the colour for the starboard side of 
the side scan coverage outline in the 
SideScan display, or the starboard 
soundings in the Plan View of Swath 
Editor.

Show Sensor 
ToolTips

ToolTips are used in the Attitude and 
Navigation Editors for displaying data 
values as the cursor moves over the 
graphs.

Show or hide tools tips by clicking the 
Tool Tips check box (checked means 
this feature is visible).

Field Description To assign a value...
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Side Scan Editor
This tab controls the colours used for the Side Scan Editor 
display. (The Port and Starboard colour palettes are set in Tools > 
Options > Display > “SENSOR EDITORS” ON PAGE 111.)

1. Select a colour from the appropriate colour palette, or create a custom 
colour from the standard Windows colour picker:
• Altitude: Sets the colour of the digitized line along the seabed that is 

used determine the height of the towfish from nadir when slant-
range correction is performed.

• Measure /Offset Tools: Sets the colour for displaying the values 
when using the Measure Distance and Measure Shadow tools, and 
the colour of the range display. 

• Contact Image Outline: Sets the colour for displaying the outline of a 
contact. 

• Show Rejected: Sets the colour of rejected pings (which are visible 
when the Show Rejected button on the Toolbar is activated)

2. Select the Display contacts during playback check box to make 
contacts visible in waterfall window during scrolling or playback.

3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.
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Single Beam Editor
This tab controls the colours for the Single Beam Editor display.

1. Set the colours for data by selecting from the appropriate colour 
palette, or create a custom colour from the Windows colour picker. 
• Primary: Colour for primary frequency soundings in a dual-

frequency system.
• Secondary: Colour for secondary frequency soundings in a dual-

frequency system.
• Selected: Colour for soundings that are selected in the Single Beam 

Editor window. 
• Track Line Highlight: The colour in the Display window for the 

section of track line selected in the Display window and visible in the 
Single Beam Editor window.

• Event Marks: A unique marker placed at regular intervals in the 
survey.

2. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.
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Status
The Status tab controls the status colours for soundings.

1. Select a colour from the colour palette, or create a custom colour from 
the colour selector within the palette. 

Status Description

Accepted Colour for data that is flagged as ready for processing.

Rejected Colour for data that is flagged as rejected and excluded from 
further processing.

Reject - With Interpolation Colour for attitude and navigation data that has been flagged as 
rejected but where associated soundings can still be processed.

Reject - Break Interpolation Colour for attitude and navigation data that has been flagged as 
rejected and where associated soundings are also rejected.

Outstanding Colour for soundings in the Subset Editor that have been 
flagged as needing further examination.

Examined Colour for soundings in the Subset Editor that have been 
flagged as examined and verified.

Designated Colour for the sounding that has been flagged in the Swath or 
Subset Editors as being the shoalest sounding on a feature.
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2. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.
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Swath Editor
Use the Swath Editor options to set colours for the Plan View 
display. Soundings can be coloured by location in the swath (port 
or starboard), or by detection method. 
Soundings in the Rear, Side, and Profile Views are always 
coloured by their location in the swath.

1. Click the By Beam Number box to enable colour options for port and 
starboard. 

Colour options for Port and Starboard are set in the Sensor 
Editors page. See “SENSOR EDITORS” ON PAGE 111

2. Click the By Detection Method box so the amplitude and phase colour 
options are enabled.

3. Use the Phase and Amplitude colour palettes to select a colour, or 
create a custom colour from the standard Windows colour selector.

4. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.
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Tide/SVP
Tide/SVP options control colour options for Sound Velocity 
Profile location symbols and tide zone lines.

1. Select a colour from the appropriate colour palette, or create a custom 
colour from the standard Windows colour picker:
• SVP Positions palette controls the colour for Symbols and text 

labels that show the positions of sound velocity profiles.
• Tide Zones control the colour for outline of tide zone areas.

2. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.
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Units 
Units options control the measurement units that are used in all 
HIPS and SIPS applications. 
 

To set Position options: 
1. Click the up or down arrow buttons beside the Precision field, or type a 

value in the field.
• Precision is the number of decimal places to the right of the decimal point 

that are displayed in expressing the value for the position of the cursor in 
the display. 

2. Select the Display units from the drop-down list.

There are four types of units:
• Geographic DD (Decimal Degrees). Example (to 3 decimal 

places): 50.361N; 4.135W
• Geographic DM (Degrees, Minutes). Example: 50-21.650N; 

004-08.423W
• Geographic DMS (Degrees, Minutes, Seconds). Example: 50-

21-39.058N; 004-08-04.671W
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• Ground (ground units). Example (in US Miles) : 548.734; 
2116.214

To set other Units options:
3. Select the Units setting from the drop-down list. 

• Horizontal Length, Vertical length and Area can be set in metric or 
Imperial units.

• Speed and Vessel speed are set in units of measure per period of 
time. 

4. Set the rounding method to be used when displaying soundings, by 
selecting a rounding/truncating rule from the drop-down list. 

A brief description of the selected rule is displayed below the 
selection. 
For more information on sounding rounding rules, see Sounding 
Rounding in the Tools Guide.

5. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

If you select Ground units you may set the unit of measure using the 
Horizontal Length field.
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Directories 
The Directories tab sets the locations of the folders that contain 
data such as raw data, tide data, projects, field sheets and saved 
sessions.
1. Select the Options command.

2. Select the Directories tab.

The root path location is written to and read from the Windows 
registry, as controlled by the Active Profile setting. The default 
profile is the current user account. 
When you set your user name as the Active Profile, all 
environment settings are written to and read from your login 
account settings in the Windows registry. (Changes made using 
this option will affect only the user who is currently logged in.)
When Administrator is selected, all environment settings are 
written to and read from the system-wide settings in the 
Windows registry. Changing these settings affects all users on 
the same machine using the Administrator profile. (Only persons 
with a Windows Power User Group or Administrator Group 
account can make changes to directories while this option is 
selected.)

M
en

u

Tools > Options

If you are running HIPS 8. for the first time, and you have chosen 
not to carry over your existing data settings that HIPS has 
detected, you will need to set the root path to your data. 

When you set the root path, if the Field Sheets, HDCS_Data, 
Preprocess, Session, SVP, Template and Tide folders do not 
exist, they will be automatically created at that location. 
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Root path The Root Path field displays the location of the HIPS and SIPS 
data directories, which are listed with their descriptions in the 
table below. The location must contain folders with the same 
names as these default data directories. 
1. Select the Root Path check box. (If you do not have Administrator 

rights, set the Active Profile to your login name.)

2. Type the path for the directory or enter the path by clicking Select and 
browsing to the new location.

3. Click Apply to implement the settings without closing the Options 
dialog box or click OK to save the settings and close the dialog box.

Directories You can change the path to an individual directory listed on the 
Directories tab. 
1. Select your login name as the Active Profile.

2. Double-click on a directory, or select it and click Select.

The Browse for Folder dialog box is displayed.
3. Expand the directory tree to view the directory you want to change to. 

4. Select the folder.

5. Click OK to close the Browse for Folder dialog box.

The new path is displayed in the Value column of the Options 
dialog box. 
6. Click Apply to implement the changes without closing the dialog box, 

or OK to implement the changes and close the dialog box.
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Environment 
1. Select the Options command.

2. Select the Environment tab.

The Environment tab sets the locations for the files which 
control environment variables used by HIPS and SIPS, such as 
colour definitions and mapping, device definitions, feature codes, 
etc. 
This information is written to and read from the Windows 
registry, as controlled by the Active Profile setting. 
The default profile is Administrator. When Administrator is selected, 
all environment settings are written to and read from the 
system-wide settings in the Windows registry. Changing these 
settings affects all users on the same machine using the 
Administrator profile. (Only persons with a Windows Power User 
Group or Administrator Group account can make changes to 
directories while this option is selected.)
However, you can override the Administrator settings and select 
the directories you want HIPS to access. When you set your user 
name as the Active Profile, all environment settings are written to 
and read from your login account settings in the Windows 
registry. (Changes made using this option will affect only the 
user that is currently logged in.)

M
en

u

Tools > Options
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To change the default environment settings, 
1. If you do not have Administrator rights, select your login name as the 

Active Profile.

2. Double-click on a directory, or select it and click Select.

The Open dialog box is displayed.
3. Click to expand the directory tree to view the directory that you want to 

change to. 

4. Select the file or folder.

5. Click OK to close the dialog box.

The new path is displayed in the Value column of the Options 
dialog box. 
Click Apply to implement the changes without closing the dialog box, or 
OK to implement the changes and close the dialog box.
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S-57 Environment 
1. Select the Options command.

2. Select the S-57 Environment tab.

The S-57 Environment tab sets the files and values used for 
displaying S-57 data in the Display window. The default 
directory for S-57 display files is ...\Program Files\ 
CARIS\HIPS\System\S57Config\.
This information is written to and read from the Windows 
registry, as controlled by the Active Profile setting. 
The default profile is Administrator. When Administrator is selected, 
all environment settings are written to and read from the 
system-wide settings in the Windows registry. Changing these 
settings affects all users on the same machine using the 
Administrator profile. (Only persons with a Windows Power User 
Group or Administrator Group account can make changes to 
directories while this option is selected.)
However, you can override the Administrator settings and select 
the directories you want HIPS to access. When you set your user 
name as the Active Profile, all environment settings are written to 
and read from your login account settings in the Windows 
registry. (Changes made using this option will affect only the 
user that is currently logged in.)

M
en

u

Tools > Options
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You can change the path to an individual listing on the tab. 
1. If you do not have Administrator rights, select your login name as the 

Active Profile.

2. Double-click on a file or folder, or select it and click Select.

If you selected a file or folder the Open or the Browse for Folder 
dialog box is displayed.
3. Click to expand the directory tree to view the directory that you want to 

change to. 

4. Select the folder.

5. Click OK to close the dialog box.

The new path is displayed in the Value column of the S-57 
Environment dialog box. 
If you select an environment value, such as Object Catalog, 
which does not have a file location, the Set Environment Value 
dialog box will be displayed.
6. Enter the new setting for that value.

7. Click OK.

The new value will be displayed.
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8. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.
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S-52 Display 
The S-52 Display tab controls the appearance of S-57 Ed. 3.1 
data shown as background data in the Display window. 
1. Select the S-52 tab and set the parameters described in the table 

below.

 

Option Description To assign a value...

Display settings

Presentation Display S-57 and HOB data in one of six different formats. Select a presentation 
format from the drop-down 
list.

Refresh 
Symbology

Automatically refresh the display to show the symbology 
associated with the selected presentation library.

Select the check box to 
make this option active.
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2. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Colours Select the time-of-day colour scheme in which to display S-57 
data: Day Bright, Day White, Day Dark, Dusk, Night. 

Select the appropriate item 
from the drop-down list.

Depths Select the number of depth shades to use: 2 or 4 (default). 
This value works in conjunction with Safety Contour, 
Shallow Water and Deep Water depths (see below).

Transparency Select a transparency setting (none, 25, 50, 75, or 100 
percent) for polygon fills in the display.

Text Font Select a font to use in the Display window. The default font is 
Times New Roman. 

Safety Contour Define which areas have sufficient depth for safe navigation. 
The safety contour is symbolized as a thick solid line. It also 
defines the boundary of shallow and deep-water areas for the 
purpose of area symbolization.

Type a value in the 
appropriate field.

Shallow Water Define the contour boundary between the two darker colours 
used for water shallower than the Safety Contour.

Safety Sounding The safety depth is used in the symbolization of soundings. 
Soundings whose depth is less than the safety depth are 
displayed in bold text.

Deep Water Define the contour boundary between the two lighter colours 
used for water deeper than the Safety Contour.

Display filters

Category Pre-defined categories of objects to be displayed Select a category from the 
drop-down menu. 

Highest Priority 
Unmasked Edges

Display only the symbolization of the highest priority, 
unmasked edges when multiple features share an edge. If the 
highest priority edge is masked, it will not display.

Select or clear the check 
box to turn these display 
options on or off.

Soundings Control the display of soundings.

Text Control the display of text.

Meta Objects Enable the display of meta-object data that represents data 
quality, accuracy, etc.

Safety Contour 
Labels/Contour 
Labels

Show labels on safety contours and/or other contours.

Error Ellipses Enable the display of error ellipses that represent error 
margins of all positioning equipment (GPD, navigation, etc.).

SCAMIN Select this option to filter features from the Display window 
display that have SCAMIN values less than the display scale. 
These features are however, still drawn in the selection or 
superselection colours if they are selected or superselected.

Option Description To assign a value...
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3D Tab 
See also “NAVIGATE THE 3D DISPLAY” ON PAGE 80 and “3D FLIGHT PATH” ON 
PAGE 86.
The 3D tab provides options for adjusting the settings of the 
keyboard and mouse controllers used to navigate through data 
in the 3D Display window. The following options are available:

• Controller Type: Select one of two types of controls to use 
when navigating the 3D View:
• Terrain Flyer: allows you to navigate from the perspective 

of the height source.
• First Person: allows you to navigate from a camera view of 

the current 3D scene. 
• Flight Speed: Controls the speed at which you move through 

the display during a fly-through. Move the slider bar left or 
right to increase or decrease flying speed.

• Zoom Speed: Controls how fast the view is changed when 
using the zoom controls. Move the slider bar left or right to 
increase or decrease zooming speed.

• Smooth-Fly-To Speed: Controls how fast the view is changed 
when you double-click an area of the 3D View. Move the slider 
bar left or right to increase or decrease zooming speed.



5
Data Directories

This section describes the Project/Vessel/Day/Line structure of the data 
directories in HIPS and SIPS. 

In this chapter...
INTRODUCTION........................................................... 132
PROJECTS ................................................................ 133
RAW DATA ............................................................... 135
SVP AND TIDE.......................................................... 136
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Introduction
The structure of the HIPS and SIPS data directories is designed 
to maximize data access efficiency during processing. By 
definition, these directories only store raw or processed data and 
products, not the HIPS and SIPS applications nor their 
associated system files and libraries. The data directories are 
listed in the following table. 
 

Data Type Default Directory Location

Projects ..\Caris\HIPS\ver\HDCS_Data

Raw data ..\Caris\HIPS\ver\Preprocess

Session files ..\Caris\HIPS\ver\Session

Field sheets ..\Caris\HIPS\ver\Fieldsheets

Tide ..\Caris\HIPS\ver\Tide

SVP ..\Caris\vHIPS\ver\Svp

For consistency with older code contained within HIPS and 
SIPS, directory names and paths should not contain any 
spaces, or any special Windows characters (\, /, :, *,?,”,<,>, 
and |).
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Projects
The Project directory holds all of the converted data. The Project 
directory contains two main components:
• HIPS and SIPS data (“HIPS AND SIPS DATA” ON PAGE 133)
• Vessel files (“VESSELCONFIG DIRECTORY” ON PAGE 134)

HIPS and SIPS Data
Converted data in HIPS and SIPS is stored in a Project/Vessel/
Day/Line (P/V/D/L) structure. Each survey project is divided into 
one or several vessels (for example, survey launches), 
contributing to the same project. The data can be from different 
generations of surveys, or different hardware collection 
platforms. Each vessel folder is divided into separate survey 
days and each survey day contains one or more survey lines.
Below is an outline of the P/V/D/L structure for a project called 
Gilligan with a vessel called Minnow. The project contains three 
line files.

In the Project directory, in addition to the folder(s) containing 
the vessel(s), there is also a HIPS Project file (HPF) that 
contains the projection information used by the HIPS and SIPS 
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interface to define the default projection for that project. When 
HIPS and SIPS accesses the navigation data (which is stored in 
un-projected latitude and longitude), the data is projected using 
the projection stored in this HPF file. The HPF is given the same 
name as the project. 
For information on creating a new project see “CREATE A NEW 
PROJECT” ON PAGE 53.
The name of the vessel in the P/V/D/L path provides the link to 
the actual HIPS Vessel File and therefore must be spelled the 
same as the HVF in the VesselConfig directory. The data cannot 
be processed if the HVF is not present or if the vessel name in 
the P/V/D/L path is misspelled.
The survey day in the P/V/D/L structure is composed of two 
components separated by a hyphen—the four-digit year and the 
three-digit Julian date. The date used in the Day directory name 
does not actually play a role in data processing—it is used as a 
convenient mechanism for organizing survey data.
When a new project is created, this P/V/D/L directory structure 
is built and the HPF is generated. The vessel file must exist in 
the VesselConfig directory at the time the project is defined, 
however it can be modified at any time (providing the name is 
not changed).

VesselConfig Directory
The VesselConfig directory contains the HIPS Vessel File (HVF) 
used in the vessel component of the P/V/D/L path. The name of 
this directory must not be changed and it always has to be 
located inside the Raw Data directory on the same level as the 
project directories.
For more information about the HVF see “VESSEL FILES” ON PAGE 22.
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Raw Data
The raw data directory is used to store un-processed files that 
are used as input into HIPS via the Conversion Wizard. Un-
processed files can be stored in any order and in any location on 
your system. However it is recommended that you store these 
files in a folder structure that mimics the P/V/D/L structure of 
the Projects folder.
Not only does the P/V/D/L structure provide a consistent path for 
data retrieval. You can also take advantage of a feature in the 
Conversion Wizard that lets you open for conversion at any level 
of the P/V/D/L folder structure and maintain that structure 
through conversion.
For example, a new project called "Gilligan" is created by the 
New Project wizard without adding a vessel or survey days to 
the project definition.
Raw data is then converted to HIPS and SIPS format through 
the Conversion Wizard. The File Selection Type is set to 
"Project" in Step 2 of wizard. The converter then knows that 
data is stored in the P/V/D/L structure and that you are loading 
from the Project level. All folders on the next level are 
interpreted as vessel names and the level after that as survey 
days.
Each vessel name must exist in the VesselConfig directory, 
otherwise the converter will report errors. In this example, there 
is only one vessel folder, called "Minnow" and it contains several 
survey days. There happens to be a HVF in the VesselConfig 
directory called "Minnow," so the converter creates the vessel 
folder beneath the project name "Gilligan" in the Project 
directory and also all of the survey days that are necessary. If 
the survey days or the vessel are already present, the converter 
uses them.
Finally, all of the lines found are converted.
To convert raw data that is not stored in the P/V/D/L structure, 
simply set the file selection type to "Raw" and select the files 
individually.
For more information on converting data to HIPS/SIPS format 
see “RENAME DAY AND LINE FOLDERS” ON PAGE 69.
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SVP and Tide

SVP
The SVP directory contains all of the sound velocity profile files. 
They can be stored in subdirectories of this directory if desired.

Tide
The Tide directory contains all of the tide files. They can be 
stored in subdirectories if desired.



6
HIPS Status Flags

Within HIPS and SIPS data structure each sensor data value has a series 
of status flags. Each profile in the depth and side scan formats, and each 
survey line also has status flags. 

The status flag settings are determined during data cleaning and 
processing. They are used to control the generation of new data layers 
such as BASE surfaces, tiles, and selected soundings.
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Status Flags and Values
 

Status Flag Value

Accepted The default status of sounding.

Rejected True if the sounding is rejected for any 
reason.

Examined Indicates that the sounding was verified.

Designated Indicates that the sounding is the shoalest in a 
cluster of soundings.

Outstanding Indicates that the sounding needs further 
examination.

Rejected by Swath Editor or 
Single Beam Editor

True if sounding was rejected in the Swath 
Editor or Single Beam Editor, or by the swath 
or single beam filters. 

Rejected by Hydrographer True for soundings rejected manually by the 
hydrographer within the Subset Editor.

Rejected by Surface Cleaning True if sounding was rejected during surface 
cleaning

Rejected by Depth Gate True for soundings rejected by the depth gate 
during conversion.

Rejected by Disabled Beam True for soundings rejected at conversion 
time because of a disabled beam flag in the 
HVF or due to a pre-flagged bad sounding in 
the original raw data format.

Rejected by TPU True for soundings rejected during Total  
Propagated Uncertainty filtering.

Rejected by surface filter. True for soundings rejected during surface 
filtering.

Rejected by Auto Classification True if the sounding fails the auto 
classification tests filter contained in the HIPS 
v4.3.3 subset mode. This flag is not used in 
v5.x software.

Rejected by Bad Navigation True if the profile was rejected for bad 
navigation.

Rejected by Bad Gyro True if the profile was rejected for bad gyro. 

Rejected by Bad Heave True if the profile was rejected for bad heave.

Rejected by Bad Pitch True if the profile was rejected for bad pitch.

Rejected by Bad Roll True if the profile was rejected for bad roll.

Rejected by Bad Tide True if the profile was rejected for bad tide.



7
Contact File Formats

Contacts are representations of features on the sea bottom that are 
visible in the sonar data. They are added to the data using the Side Scan 
Editor. Information about the contacts in a project can be exported into 
the file formats described here.

In this chapter...

INTRODUCTION........................................................... 140
CONTACTLINE ........................................................... 141
CONTACTSINGLE........................................................ 142
CONTACTMULTI ......................................................... 144
CONTACTMULTIPOINTS ............................................... 146
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Introduction
Contacts are created in the Side Scan Editor waterfall view. An 
contact file in ASCII format is created for the selected survey 
line and stored in its line folder within the project directory 
structure. For information on creating and editing contacts, see 
CONTACTS ON PAGE 81 OF THE HIPS AND SIPS EDITORS GUIDE.
When you export contacts, all of these files together produce a 
single set of output files that represent all contacts from all of 
the survey lines in your project. 
The Contact export function from SIPS produces four files:
• filename_ContactLine.txt contains information identifying 

the survey line and indexes to the other files.
• filename_ContactSingle.txt contains all the information for 

single point contacts.
• filename_ContactMulti.txt contains all information for single 

point contacts.
• filename_ContactMultiPoints.txt contains all location 

information for multipoint contacts.
• filename_ContactTiff.gat contains all image files created 

during export.
These files are saved in the folder, and with the filename you set 
during export. See CONTACTS ON PAGE 502 OF THE HIPS AND SIPS USER 
GUIDE for information on exporting contact data for the project.
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ContactLine
The filename_ContactLine.txt file contains the names of the 
HIPS track lines and the corresponding index number. Each line 
in the file is a comma- delimited string terminated by the 
newline character (\n). Each line has the following format: 

Field Name Field Description Description

Line Index 4-digit integer The index number for the line.

Project Name 256 characters 
(maximum) 

The name of the HIPS project that the line belongs to.

Vessel Name 256 characters 
(maximum) 

The name of the HIPS vessel that the line belongs to.

Day Name 256 characters 
(maximum) 

The name of the HIPS day that the line belongs to.

Line Name 256 characters 
(maximum)

The name of the HIPS line that the contact refers to.
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ContactSingle
The filename_ContactSingle.txt file contains the list of single 
point contact features from the export. Each line in the file is a 
comma (',')delimited string terminated by a new line character 
('\n'). Each line in the file has the following format:

Field Name Field Description Description

Contact Index 4-digit integer The index number for the contact. Index numbers are assigned 
sequentially from 0 when the export is performed. Guaranteed to be 
unique for all exported single contacts only.

Key 12 characters The key for the contact. This is created by concatenating the line 
name and the contact number together. The first 8 bytes are the first 8 
bytes in the line name, and the last 4 bytes are the system generated 
number assigned to the contact.

Line Index 4 digit integer The line record number from the corresponding 
Filename_ContactLine.txt file.

Contact 
Number

4 digit integer The system generated contact number assigned to the contact when it 
was created in the SIPS software (same as the last 4 bytes of the ‘key’ 
field).

Creation Date 10 characters The date the contact was created. Has the mm/dd/yyyy format

Creation Time 10 characters The time the contact was created. Has the following format: 
HH:MM:SS.S

Created User 
ID

3 characters The user ID entered in the SIPS software at the time of contact 
creation (usually user initials)

Modified Date 10 characters The last date the contact was modified. It may be the same as the 
Creation Date if the contact has not been modified since creation. It 
has the following format: mm/dd/yyyy

Modified Time 10 characters The time of the last modification done to the contact. The time may be 
the same as the Creation Time if the contact has not been modified 
since it was created. It has the following format: HH:MM:SS.S

Modified User 
ID

3 characters The user ID of the user that last modified the contact. The ID may be 
the same as the Created User ID if the contact has not be modified 
since it was created.

Contact Prefix 8 characters The prefix assigned by the SIPS software when the user created the 
contact. This is normally used to generate the key for the contact.

Feature Code 12 characters The CARIS Feature code used to represent the point contact.

Contact Type 1 character This identifies the contact record as either a single point or multi point 
contact. Single point contacts are represented by a ‘1’ and multipoint 
contacts are represented by a ‘2’.

Profile Number 4 digit integer The profile number that the contact was picked from in the SIPS 
software.

Across 
Distance

6.2 Floating point The across-track distance recorded by the SIPS software that the 
point contact was picked from.

Latitude 13.7 Floating point The latitude of the point contact.

Longitude 13.7 Floating point The longitude of the point contact.
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Target Height 6.2 Floating point The height of the target (in metres).

Target Width 6.2 Floating point The width of the target (in metres).

Target Length 6.2 Floating point The length of the target (in metres).

Image Height 4 digit integer The height of the contact image as defined by the user in the SIPS 
software.

Image Width 4 digit integer The width of the contact image as defined by the user in the SIPS 
software.

Status 1 digit integer The status of the contact. 0 if the contact is Accepted, 1 if the contact 
is Rejected.

Remarks 85 (maximum) 
characters

Remarks entered by the hydrographer about the created contact.

Field Name Field Description Description
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ContactMulti
The filename_ContactMulti.txt file contains the list of 
multipoint contact features from the export. Each line in the file 
is a comma (',') delimited string terminated by a newline 
character ('\n'). Each line in the file has the following format:

Field Name Field Description Description

Contact Index 4-digit integer The index number for the contact. Index numbers are assigned 
sequentially from 0 when the export is performed. It is 
guaranteed to be unique for all exported multi point contacts 
only.

Key 12 characters The key for the contact. It is created by concatenating the line 
name and the contact number together. The first 8 bytes are the 
first 8 bytes in the line name, and the last 4 bytes are the system 
generated number assigned to the contact.

Line Index 4 digit integer The line record number from the corresponding 
Filename_ContactLine.txt file.

Contact Number 4 digit integer The system generated contact number assigned to the contact 
when it was created in the SIPS software (same as the last 4 
bytes of the ‘key’ field).

Creation Date 10 characters The date the contact was created. It has the mm/dd/yyyy format

Creation Time 10 characters The time the contact was created. It has the following format: 
HH:MM:SS.S

Created User ID 3 characters The user ID entered in the SIPS software at the time of contact 
creation (usually user initials)

Modified Date 10 characters The last date the contact was modified. The data maybe the 
same as the Creation Date if the contact has not been modified 
since creation. It has the following format: mm/dd/yyyy

Modified Time 10 characters The time of the last modification done to the contact. The time 
maybe the same as the Creation Time if the contact has not 
been modified since it was created. It has the following format: 
HH:MM:SS.S

Modified User ID 3 characters The user ID of the user that last modified the contact. The ID 
maybe the same as the Created User ID if the contact has not 
be modified since it was created.

Contact Prefix 8 characters The prefix assigned by the SIPS software when the user 
created the contact. This is normally used to generate the key 
for the contact.

Feature Code 12 characters The CARIS Feature code used to represent the point contact.

Contact Type 1 character This identifies the contact record as either a single point or multi 
point contact. Single point contacts are represented by a ‘1’ and 
multipoint contacts are represented by a ‘2’.

Target Height 6.2 Floating point The height of the target (in metres).

Target Width 6.2 Floating point The width of the target (in metres).

Target Length 6.2 Floating point The length of the target (in metres).
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Image Height 4 digit integer The height of the contact image as defined by the user in the 
SIPS software.

Image Width 4 digit integer The width of the contact image as defined by the user in the 
SIPS software.

Status 1 digit integer The status of the contact—0 if the contact is Accepted, 1 if the 
contact is Rejected.

Remarks 85 (maximum) 
characters

Remarks entered by the hydrographer about the created 
contact.

Field Name Field Description Description
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ContactMultiPoints
The filename_ContactMultiPoints file contains the list of points 
used to construct the geometry of the multi point contacts listed 
in the Filename_ContactMulti.txt from the export. Each line in 
the file is a comma (',')delimited string terminated by a newline 
character ('\n'). Each line in the file has the following format:

Field Name Field Description Description

Record number 4-digit integer The record number. It is unique throughout the file.

Contact Record 
Number

4-digit integer The contact record number that this point belongs to. This 
corresponds to the Contact Index in the corresponding 
Filename_ContactMulti.txt file.

Profile Number 4-digit integer The profile number that the point was computed from in the SIPS 
software.

Across 
Distance

6.2 floating point The across-track distance recorded by the SIPS software that the 
point contact was picked from.

Accumulated 
Distance

6.2 floating point The accumulated distance. This is the distance from the first point 
in the set, to this point.

Latitude 13.7 floating point The latitude of the point.

Longitude 13.7 floating point The longitude of the point.
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Tide File Formats

HIPS supports a standard Canadian Hydrographic Service tide format 
called COWLIS as well as two NOS/NOAA formats. HIPS also supports a 
basic format consisting of just the required date, time, and tide values.

HIPS does not use predicted tide tables. The time zone of the tidal 
observation data must match the time zone of the bathymetry to which it 
will be applied.

As an alternative, a Computed GPS Tide calculation can be used with 
data in HIPS

In this chapter...
TIDE FILES (*.TID) ...................................................... 148
COWLIS ................................................................ 149
NOS PRELIMINARY TIDE DATA .................................... 150
NOS FINAL TIDE....................................................... 151
TIDE ZONE DEFINITION FILES....................................... 153
GPS TIDE FORMAT .................................................... 156
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Tide files (*.tid)
TID files are ASCII files consisting of date, time, and tide values 
collected from a single tide station. These files can be created or 
edited in a text editor (such as Notepad), or in the Tide Editor.
The following tide data file formats are supported by HIPS:
• CHS Cowlis
• CHS TMS 50
• CHS TMS 1000
• NOS Preliminary Tide Data
• NOS Final Tide Data
• NHS Tide file

Basic Tide Format The basic tide format used by HIPS begins with a single line 
containing at least 8 dash characters, followed by tidal 
observation records consisting of date, time, and tide. Here is a 
simple example:

--------

2000/11/01 00:00   0.522    
2000/11/01 01:00   0.317     
2000/11/01 02:00   0.395   
2000/11/01 03:00   0.751    
2000/11/01 04:00   1.296    
2000/11/01 05:00   1.848    
2000/11/01 06:00   2.339 
2000/11/01 07:00   2.589 

To apply tide data, see “CORRECT FOR TIDE” ON PAGE 139 in the User 
Guide. See also “TIDE EDITOR” ON PAGE 767 in the Editors guide.
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COWLIS 
--------------------- LIBEX file dump ----------------------
----------------------- STN?????.OBS -----------------------
------------------ Time Zone:  GMT ( 0.0) ------------------

--------------------- Invariant Fields ---------------------
Name             Type Size    Units Value
------------------------------------------------------------
station_id       CHAR    5          
station_name     CHAR   16          Rimouski, Quebec
data_product     CHAR    3          TMS1000
start_time       INTG    4  seconds 93/06/29 18:45:00
end_time         INTG    4  seconds 91/11/16 20:45:00
file_date        INTG    4  seconds 95/12/20 15:24:24
max_water_level  REAL    4   metres    1.640
min_water_level  REAL    4   metres    0.050
------------------------------------------------------------

---------------------- Variant Fields ----------------------
Name             Type Size    Units
------------------------------------------------------------
time             INTG    4  seconds 
water_level      REAL    4   metres 
std_dev          REAL    4   metres 
------------------------------------------------------------
1993/06/29 18:45:00   1.95  0.030
1993/06/29 19:00:00   1.84  0.030
1993/06/29 19:15:00   1.74  0.030
1993/06/29 19:30:00   1.63  0.030
1993/06/29 19:45:00   1.55  0.030
1993/06/29 20:00:00   1.48  0.030
1993/06/29 20:15:00   1.41  0.030
1993/06/29 20:30:00   1.37  0.030
1993/06/29 20:45:00   1.34  0.030
-------------------- End Of LIBEX File ---------------------
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NOS Preliminary Tide Data

************************ PRELIMINARY DATA **************************

     THIS RAW DATA HAS NOT BEEN SUBJECT TO THE NATIONAL OCEAN SERVICE’S
     QUALITY CONTROL OR QUALITY ASSURANCE PROCEDURES AND DOES NOT MEET
     THE CRITERIA AND STANDARDS OF OFFICIAL NATIONAL OCEAN SERVICE
     DATA.  IT IS RELEASED FOR LIMITED PUBLIC USE AS PRELIMINARY DATA TO
     BE USED ONLY WITH APPROPRIATE CAUTION.

************************ PRELIMINARY DATA **************************

      Water Level -  Acoustic (A1)
      Station   --   Unique seven character identifier for the station
      DCP       --   A one character identifier for the data collection
                     platform at a station
      SE        --   A two character identifier for the data sensor
      Date Time --   Date and time the data were collected by the DCP
      WL_Value  --   Water level height
      Sigma     --   Standard deviation of 1 second samples used to
                     compute the water level height
      Out       --   Count of number of samples that fall outside a
                     3-sigma band about the mean
      Flat      --   A flag that when set to 1 indicates that the flat
                     tolerance limit was exceeded
      ROFC      --   A flag that when set to 1 indicates that the rate
                     of change tolerance limit was exceeded
      Temp      --   A flag that when set to 1 indicates that the
                     temperature difference tolerance limit was exceeded
      Limit     --   A flag that when set to 1 indicates that either the
                     maximum or minimum expected water level height limit
                     was exceeded

      Data are in meters above MLLW
      Times are on UTC (GMT)

9453220 1 Yakutat, AK  from  19990614 to 19990618
  ------------------------------------------------------------------------
Station  DCP  SE  Date       Time   WL_Value   Sigma  Out Flat RofC Temp Limit

9453220   1   A1  1999/06/14 00:00     1.881   0.014   0    0    0    0    0
9453220   1   A1  1999/06/14 00:06     1.814   0.025   0    0    0    0    0
9453220   1   A1  1999/06/14 00:12     1.746   0.018   0    0    0    0    0
9453220   1   A1  1999/06/14 00:18     1.692   0.014   0    0    0    0    0
9453220   1   A1  1999/06/14 00:24     1.632   0.013   0    0    0    0    0
9453220   1   A1  1999/06/14 00:30     1.560   0.015   0    0    0    0    0
  ------------------------------------------------------------------------
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NOS Final Tide

 NOS SIX MINUTE WATER LEVEL HEIGHTS

      Data are verified

      Station   --   Unique seven character identifier for the station
      Date Time --   Date and time the data were collected by the DCP
      WL_Value  --   Water level height
      Sigma     --   Standard deviation of 1 second samples used to
                     compute the water level height
      Infer     --   A flag that indicates that the water level value
                     has been inferred.
      Flat      --   A flag that when set to 1 indicates that the flat
                     tolerance limit was exceeded
      RofC      --   A flag that when set to 1 indicates that the rate
                     of change tolerance limit was exceeded
      T_Flag    --   A flag that when set to 1 indicates that the
                     temperature difference tolerance limit was exceeded

      Data are in meters above MLLW
      Times are on UTC (GMT)

9452210 Juneau, Gastineau Channel, Stephens Pass, AK, USA  from  19980525 to 
19980530
  ------------------------------------------------------------------------
Station Date       Time    WL_Value   Sigma  Infer Flat RofC T_Flag

9452210 1998/05/25 00:00     2.473     0.019     0    0    0     0
9452210 1998/05/25 00:06     2.330     0.022     0    0    0     0
9452210 1998/05/25 00:12     2.200     0.019     0    0    0     0
9452210 1998/05/25 00:18     2.064     0.020     0    0    0     0
9452210 1998/05/25 00:24     1.938     0.019     0    0    0     0
  ------------------------------------------------------------------------
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NHS (Norwegian Hydrographic Service) 
This is an example of an NHS tide file.
 

#Site name: Stavanger
#Provider: Norwegian Hydrographic Service
#Latitude: 58.9700
#Longitude: 5.7300
#Datum: EUREF89
#Time interval: 600 seconds 
#Reference level: CD (Chart Datum)
#Series1: Water level observations
#Series2: Predicted tide
#Series3: Residuals (observed-predictions)
#Unit: cm

2011-12-24T00:00+01 97.0 82.0 15.0
2011-12-24T00:10+01 97.0 81.0 16.0
2011-12-24T00:20+01 96.0 80.0 16.0
2011-12-24T00:30+01 94.0 79.0 15.0
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Tide Zone Definition Files
 The following is an example of a Zone Definition File (.zdf).

Tide Zone Data The Zone Definition File has the following components:
• The mandatory header section must consist of this text string: 

[ZONE_DEF_VERSION_3]. This specifies the version of the 
Zone Definition File. 

• The section labelled [ZONE] contains the name of the zone(s) 
and the coordinates that define the boundary of the zone(s). 
All tide zone files must contain this section. 
There are two fields in the first line:
• <Zone Label> contains name of the zone (the name must 

not be longer than 256 characters).
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• number of points that define the boundary of the zone. 
(These are listed starting in the next line of the section.)

The remaining lines in this section list the geographic 
coordinates of these points, (latitude, longitude) in decimal 
degrees.
The last line in the list must contain the same coordinates as 
the first line to close the polygon.
If there is more than one zone being defined, this section is 
repeated with the definition information for each zone. 

• The section labelled [TIDE_STATION] contains the definition 
of the tide stations collecting the tide observations. There are 
six fields in each record of this section:
• station label (the name of the tidal station) - The name 

must not be longer than 256 characters.
• latitude in decimal degrees - Valid ranges are from -90.0 to 

+90.0. The negative range represents the Southern 
Hemisphere.

• longitude in decimal degrees - Valid ranges are from -180.0 
to +180.0. The negative range represents the Western 
Hemisphere.  

• max amplitude (in metres) expected from the tidal station - 
This value will be used to compute a scaling factor during 
the Tidal TPU computation.   

• uncertainty error value associated with the data from the 
station (in metres)

• [optional] full file path and name, or just the name of the 
tide file associated with the station ID. If this is omitted, 
HIPS will look for an observation file in the same directory 
as the *.zdf, with the file name <Station_Label>.tid.

• The section labelled [TIDE_ZONE] contains specific 
attributes that define a zone’s tidal parameters. There are 
seven fields in this section:
• tide zone label - this must match the name of the zone(s) 

defined in the [ZONE] section.
• tide station label - name of the tidal station associated with 

this entry.
• priority designation of the tidal station entry: either the 

primary (PRIM), secondary (SEC), tertiary (TER) or 
preliminary (PRELIM) station for this zone.

• time correction - the tide offset for this zone (in minutes)

Tide zones should not overlap each other.
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• range correction - a multiplier (for example, 1.06) used to 
scale the tidal value read from the observation file

• tidal shift - a number in metres added to the values after 
range correction has been applied. 

• uncertainty value for the tidal zone (in metres) used to 
compute the Tidal Zone Error. 

• The section labelled [TIDE_AVERAGE] assigns tide stations 
to zones for tide-weighted averaging. Each record has at least 
two station fields because each zone can be assigned one or 
more tide stations for the weighted average calculation. 
The section has the following fields:
• tide zone label - the zone (as defined in the [ZONE] section) 

to which the averaging should be applied
• tide station label, (as defined in the [TIDE_STATION] 

section). Enter as many as needed for averaging.
• The last section labelled [OPTIONS] contains options used 

during tide zoning or tide averaging. 
• The limit value field contains the outage time in minutes 

before switching from the current station to the next 
priority station

• final interval in seconds of tide data loaded into the track 
line.

For information on applying the data in a ZDF to survey lines 
see “CORRECT FOR TIDE” ON PAGE 139 in the User Guide.
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GPS Tide format
The Compute GPS (Global Positioning System) Tide function 
provides an alternative to normal tidal observation for reducing 
soundings to the sounding datum
It is based on the recorded GPS ellipsoid height of the navigation 
antenna and uses the recorded vessel motion, if available, to 
reduce the ellipsoid height measurements to water level.
The formula for calculating GPS tide is:
GPS Tide = GPS Height - Datum Height + Antenna Offset - Heave 
+ Dynamic Draft + Height Offset - Waterline Offset

The image below demonstrates the values in the GPS tide 
formula. The arrows indicate the positive sense of the values.

This diagram and equation show the formula for GPS tide where 
GPS Height needs to be motion corrected. However, in some 
systems, GPS Height may already be motion corrected. Applying 
sensor values (such as dynamic heave) again will only distort the 
final GPS Tide. The Compute GPS Tide command lets you 
include or omit selected sensor values.
To compute GPS tide, see “GPS TIDE” ON PAGE 145 of the User Guide.
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Sounding datum models
When applying the sounding datum height(s) (distance from the 
ellipsoid to the sounding datum) to a track line, these methods 
may be used: 
• apply a single height to a track line, or, 
• apply a selected surface layer, with a set elevation attribute, 

or,
• apply a gridded binary (.bin) file, or,
• apply a sounding datum model file in ASCII format, that 

contains a grid of sounding datum heights (with either 
Ground or Geographic coordinates).

Sounding datum heights can be applied for Computing GPS tide. 
ASCII datum model files do not need to follow a specific format 
or have a specific extension. However, when an ASCII datum file 
is selected as the datum model, a *.info must also be opened to 
control the parsing of the ASCII data. (See “INFO FILE” ON PAGE 160.)
As well, a coordinate system must be selected to identify the 
position information in the ASCII file.
XYZ and BIN files used in the Compute GPS Tide function can 
be opened as background data. (See “OPEN BACKGROUND DATA” ON 
PAGE 46.) 
When an XYZ is opened in HIPS, the selection of *.info and 
coordinate system is saved in a file with the same name of the 
.xyz file, but with a "_rxl" suffix. 
For example, if you select "mydata.xyz", then "mydata.xyz_rxl" 
will be created in the same directory as the original XYZ file. If 
you open the same .xyz file again, the information from this file 
is automatically used.
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In this chapter...
INFO FILE................................................................ 160
SUPPORTED SONARS .................................................. 165
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INFO file
Files with a INFO extention, such as the sample file below, 
contain the locations of the positional (Lat/Long) and other 
attributes in the ASCII format files. 
Info files are used by HIPS to parse the information from the 
XYZ file when opening as background data ( see “OPEN DATUM MODEL 
FILE” ON PAGE 47) or for such processes as Compute GPS Tide (see 
“SOUNDING DATUM MODELS” ON PAGE 157).
“FILE STRUCTURE” ON PAGE 160

“POSITION COMPONENTS” ON PAGE 162

File structure
Files in ASCII format can have their data arranged in fixed 
columns or in free format. An info file defines which parts of the 
ASCII file contain the data that is needed by HIPS and SIPS. 
In XYZ files the data includes coordinates as well as a depth or 
height value. These numeric values, which can be called fields, 
or attributes, can be separated in each line by a space or other 
delimiterdelimiter. 
The first part of the file defines what character is used in the 
ASCII file as a delimiter or spacer between the fields of data in 
each line. Then it specifies the number of spaces or lines to be 
skipped between the beginning of the file and the start of the 
essential data, for example, if some lines contain a file header 
that is not needed for the HIPS process. 
Next, the*.info file locates the essential position information 
used by HIPS when reading ASCII sounding datum files: the X, 
Y,Z coordinates. For fixed-width formatted files, this is done by 
defining the starting position and length of each column 
containing coordinate data. (This function is optional for 
delimited files.) 
There are options to define a multiplier or offset if it is needed to 
transform a value when it is used by HIPS. For example, the 
value may be stored with an implied decimal point, and the 
multiplier will need to be applied to convert the ASCII value. 
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The sample file xyzformatinformation.info (displayed 
below) is included in the installed Template directory.
See “POSITION COMPONENTS” ON PAGE 162 for a description of its 
contents.
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Position components 
In info files the delimiter can be a TAB character or any letter, 
number or symbol. In the XYZ example below, the values are 
separated by commas, so, in the info file the Delimiter would be 
expressed as “,”. 

Since this comma-delimited file does not have a heading, in the 
info file the number of Skip Lines is set to “0”.

Col 0 Col 1 Col 2 Col 3
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The Position information section first defines a multiplier for 
each coordinate. If no adjustments need to be made to the 
coordinate information then this value is set to “1”.
Then the location of the values of the X, Y and Z coordinates are 
given. 

• If the ASCII file is free form format, with fields of varying 
lengths separated by delimiters, a Col_Index value and a 
delimiter value must be specified. 

• If the file is in fixed column format, the Start position and 
the width of the value field are defined. 

Column Index The column index value, Col_Index, assigns a column number to 
each field or attribute in the file. This number corresponds to the 
columns in the ASCII file. The columns are numbered from left 
to right, starting with 0. So X (Longitude) would be column 0, 
Y (Latitude) would be column 1 and Z (Primary Elevation) would 
be column 2. 
In the example above, commas are the delimiters, and four 
columns ( 0-3) are identified (as highlighted in the example). 

Start and Width Alternatively, you can identify the data boundaries for each 
attribute column by using the Start_Pos and Width fields. These 
fields are also used for XYZ files in fixed column format. 
Using the start and width values, each character in a line is 
numbered and the number of characters in each attribute value 
is used to identify a column. The characters in the line are 
numbered from left to right, starting with 0 and continued until 
the end of the line. For example a line with 6 attribute columns 
might have 70 characters.
In the example above, the first attribute column would have a 
start value of 0 with a width value of 11 because there are 11 
characters in the X (Longitude) value. The second column (Y or 
Latitude) would start with the next consecutive number, making 
the start value 12. It has a width value of 11, taking up 
characters 12 to 23 in the array of numbers. The start value of 
the third column (elevation) would then be 24 and the width 
value would be 5.
• x values: Start_Pos = 0; Width = 11
• y values: Start_Pos = 12; Width = 11
• z values: Start_Pos = 24; Width = 5
The start position and width values can also be used to omit 
character columns of information from the attribute.
For example, to omit coordinate quadrant information where:
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• the quadrant is the last character:

x values: Start_Pos = 0; Width = 11; y values: Start_Pos = 12; 
Width = 12

• the quadrant is the first character:

x values: Start_Pos = 1; Width = 11; y values: Start_Pos = 12; 
Width = 12

If data is in a delimited file where the coordinates have a fixed 
precision, including quadrant information, this can be extracted 
using the Start_Pos and Width relative to the delimiter 
character. For example, the following data,

could be read with an INFO file set with a delimiter of a single 
space character (' ') and the following values for the coordinates:
• x values: Col_Index = 1, Start_Pos = 0; Width = 9;
• y values: Col_Index = 0, Start_Pos = 0; Width = 9;
• z values: Col_Index = 2, Start_Pos = 0; Width = 0;
Note that the width value does not include the quadrant letter, 
so only the non-letter characters of the coordinates will be read.
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Support Files: Supported sonars

Supported sonars 
The file devicemodels.xml lists the sonar models supported by 
HIPS and SIPS. The sonar information page on the CARIS 
website, (http://www.caris.com/tpu/idx_sonar.cfm) lists the sonar 
specifics that are included in the devicemodels file. The file is 
located in the system directory. 
This file can be modified, but users are cautioned that because of 
the important role of the devicemodels.xml file particularly in 
computing TPU, this should only be done by advanced users. 
(Contact CARIS Customer Support for assistance.) 
Illustrated below is a section of the devicemodels.xml file 
showing some of the data it contains.
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Support Files: Supported sonars
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Glossary

altitude The height of the side scan sonar transducer above the sea floor. The 
transducer is typically mounted on a towed body or the surface vessel, but 
can also be mounted on an ROV or AUV.

Attitude Data Commonly used to refer to the orientation of the vessel in three dimensions 
as represented by the Gyro, Heave, Pitch, and Roll sensors. The Attitude 
Editor displays this data as well as other sensors that consists of simple 
“time vs. sensor value” data.

background data Georeferenced vector and raster data providing visual context to the 
bathymetry and side scan data being processed. Examples include CARIS 
files, BSB raster charts, GeoTIFF orthophoto images, S-57 electronic chart 
data.

backscatter Intensity of sounding returns collected by swath multibeam sounding 
systems. Backscatter data creates an image of the sea floor that can 
indicate the bottom type.

BAG The Bathymetric Attributed Grid (BAG) is an open-source binary file format 
for transferring gridded bathymetry and uncertainty values between 
software applications and agencies. The file contains five elements:  
metadata (in XML format), elevation, uncertainty, tracking, and certification. 
For more information on BAG, go to http://www.opennavsurf.org/.

BASE surface The Bathymetry Associated with Statistical Error (BASE) surface. A 
georeferenced TIFF representation of the seabed derived from processed 
bathymetry and computed uncertainty (error) values. The algorithm applies 
soundings to the grid based on beam footprint size. A customizable 
weighting system allows more emphasis in the mean calculation to be 
placed on the inner nadir beams or on soundings with lower uncertainty 
values.

beam A single depth measurement is produced from a beam. Many beams make 
up a profile or a ping.

Beam Averaged A single backscatter return value (intensity, dB) is logged with each beam, 
taken as an average intensity centred on the bottom detect of the entire 
time series to produce an image of the seafloor. The intensity for each 
beam can be directly georeferenced using the positioned beam footprint, 
but spatial resolution is lost by reducing the full time series to a single value.
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Beam Pattern 
Correction

Beam pattern correction uniformly removes along-track banding inherent to 
the sonar beam. This effect is produced by each transducer uniquely.
Beam pattern correction relies on a user-generated beam pattern file to 
identify and remove this effect. 

BIOT model Theory for acoustic propagation in a porous and elastic medium. This 
model may be used if the sediment is known to be particularly porous. 
Advanced Geocoder parameters relating to this model include porosity, 
tortuosity, and permeability.

cable out Length of cable (tow wire) deployed from a towpoint to the towfish. Used in 
the calculation of layback.

CARIS file Now called CARIS map format, this records vector map data features such 
as lines, symbols, text, soundings, etc. It consists of a set of files.

CATZOC The zone of confidence (CATZOC) attribute. The CATZOC attribute is part 
of the S-57 Quality of Data (M_QUAL) object class. It indicates that data 
meets the minimum criteria for seafloor coverage, and position and depth 
accuracy as defined by the attribute classification structure. There are five 
CATZOC classifications: A1, A2, B, C, and D.    

contacts Point and line features identified in side scan sonar data. Attributes 
describing the location, size, and description or the target are recorded. 
Image snapshots are also generated.

CUBE surface A Combined Uncertainty and Bathymetry Estimator (CUBE) surface 
contains multiple hypotheses representing potential depth variances on the 
seafloor. As soundings are propagated to nodes—based on distance and 
uncertainty—a hypothesis is developed. If the there is a significant variation 
of depth at a node, a new hypotheses is created. A node can contain more 
than one hypothesis.   

d value Shows the confidence in the grain size assessment and sediment analysis 
completed by Geocoder. Smaller values indicate more confidence in the 
assessment, with values below 0.5 being very good and values above 1.0 
being potentially inconclusive. Appears when using Advanced Sediment 
Analysis.

day One of the days for which there is survey data. Expressed as a Julian day.

decimate Decrease the size of the bathymetric data set to be exported to the work file.
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delta draft A “time vs. delta-draft” data structure that can be loaded into HIPS and used 
to model the dynamic squat and lift of the vessel. Also used to store the 
recorded depth of towfish and ROV/AUV mounted multibeam sonars.

density In Mosaic Editor: a unitless advanced Geocoder parameter measuring the 
ratio of sediment density to water density.
A BASE Surface attribute: The number of soundings contributing to a node

Despeckle Despeckling uses a calculated value based on neighbouring intensity levels 
to replace the current pixel’s intensity if it is outside the specified range. The 
value calculated from the neighbouring intensities can be derived by one of 
two methods mean or median.

disambiguation The process in CUBE of selecting one hypothesis over other hypotheses to 
represent the surface. Hypotheses can be selected or "nominated" by 
density, locale, locale and density, or by the nearest value to a previous 
CUBE Surface. 

DpTPU Depth Total Propagated Uncertainty. The difference between the observed 
or computed depth value of a sounding and its true depth value (at a 95% 
confidence level).

ellipsoid The ellipsoid and datum to which logged positions in the survey refer must 
be stored in the HIPS vessel file, regardless of whether projection 
coordinates or geographic coordinates are stored in the logged file. Any 
ellipsoid may be used, so long as it is defined in the file referenced by the 
environment variable uslXdatum.

field sheet A collection of data products, within a defined geographic area, derived 
from the processed bathymetry and side scan data. A common coordinate 
system reference is used. Some example products include BASE surfaces, 
mosaics, tiles, selected soundings, contours, and plot layouts.

filtering The process of detecting outliers in the data and setting the status flags to 
Rejected. Data points are not removed from the HIPS/SIPS format.

frequency Number of acoustic waves produced per second (Hz).

Gain A measure of increase in amplitude of a signal.

Gain Correction Gain Correction adjusts signal intensities using independent port and 
starboard Gain factor settings. Gain correction can also be applied 
uniformly to both sides.
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gamma An advanced Geocoder parameter indicating the spectral exponent of 
bottom relief.

Generic Data Parser A program for converting recorded ASCII data sources into the HIPS/SIPS 
format. New survey lines can be generated for single beam bathymetry, or 
the program can update a sensor within an existing HIPS or SIPS project.

GPS Tide Instantaneous water level height above the sounding datum derived from 
the observed GPS ellipsoid heights of the navigation antenna. Reduced for 
sensor offsets, vessel motion, known sounding datum height above the 
ellipsoid, and other parameters.

grain size An advanced Geocoder parameter indicating the size of a particle in phi.

holiday Formed when enough significant data gaps are clustered together within a 
specified radius. 

HOB The Hydrographic Object Binary (HOB) file is a spatially referenced dataset 
that is used to support the internal structure of S-57 data in CARIS 
products. The HOB file does not require a CARIS vector map and contains 
the point, line, and area geometry for hydrographic objects.

HVF HIPS Vessel File. A vessel configuration file in XML format that consists of 
a list of sensors with their physical and calibration measured offsets, plus 
any error values. These are applied to the observed data during 
processing. The HVF supersedes the Vessel Configuration File (VCF).

hypothesis A representation of depth in a BASE Surface. The Hypotheses that are 
displayed in the Surface are selected or "nominated" through 
disambiguation. Hypotheses that were not selected remain as alternative 
hypotheses and can be nominated in the Subset Editor.

HzTPU Horizontal Total Propagated Uncertainty. The difference between the 
observed or computed position value of a sounding and its true position 
value (at a 95% confidence level).

index contour A contour line accentuated by a heavier line weight to distinguish it from 
intermediate contour lines. Index contours are usually shown as every fifth 
contour with their assigned values, to facilitate reading elevations.

interface backscatter Scattering of the acoustic energy (or acoustic impedance) that occurs at the 
sediment-water interface where the seafloor acts as a reflector and 
scatterer of the incident acoustic energy.
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Kirchkov backscatter Scattering of acoustic energy due to seafloor roughness.

LADS Laser Airborne Depth Sounder (LADS) is a LIDAR system developed by 
Tenix Corporation.

layback If a towed sensor is used during a survey, the position of that sensor can be 
calculated as a horizontal “layback” from the position of the towing vehicle. 
The sensor layback is computed from the tow wire length and sensor depth.

LIDAR Light Detection And Ranging. LIDAR uses laser technology to calculate 
bathymetry. 

line A single pass of the survey vessel over some or all of the area being 
surveyed, during which time referenced sensor data is continuously 
collected. Often the line is approximately straight. 

loss An advanced Geocoder parameter measuring the ratio of the imagined wave 
number to the real wave number for the sediment.

Merge The process of calculating final positions and depths for soundings, based 
on all relevant inputs such as observed depths, navigation information, 
vessel dynamics such as gyro, heave, pitch and roll, and tide. Merging is 
carried out after these inputs are loaded and checked.

mosaic A geo-referenced raster image composited from imagery on one or more 
survey lines within a field sheet.

outliers Unwanted data resulting, for example, from incorrect sea floor detection.

permeability An advanced Geocoder parameter measuring the ability of a material (e.g. rock or 
sediment) to transmit fluids. A factor in the Biot model.

phi A unitless number used to represent particle grain size in the Sediment 
Analysis tool. 

ping A single output pulse of a sonar system.
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Plot Composer A comprehensive plotting utility that can be used to efficiently produce 
paper products that illustrate raster and vector geospatial information. The 
application cane be opened from the CARIS > Utilities folder on the 
Windows Start menu.

point cloud A set of vertices in a three-dimensional coordinate system. In HIPS and 
SIPS these vertices are usually defined by X, Y, and Z coordinates, and 
represent data in 3-D display. 

porosity An advanced Geocoder parameter measuring the fraction of voids in a 
medium (e.g. rock or sediment), or the water space between grains of 
sediment. A percentage that is a factor in the Biot model.

profile / swath A set of soundings, approximately perpendicular to the ship’s track, which 
is produced by the swath or sweep sonar over an instantaneous or very 
short time period. 

 product surface A shoal-biased bin generated from a BASE Surface. Data is down-sampled 
so that finer details of the seafloor are not visible, but the shoals are still 
maintained. Product surfaces can be used to create navigation products, 
such as Electronic Navigational Charts.

project A survey area with data collected by one or more survey vessels over one 
or more days.

raw side scan Time indexed imagery profiles where the across-track scale is time in 
milliseconds.

roughness An advanced Geocoder parameter measuring the spectral strength (cm4) 
of bottom relief at wave number 1. Stronger returns would indicate a 
rougher bottom.

S-44 S-44 is the international standard developed and maintained by the 
International Hydrographic Organization (IHO) that sets the minimum 
standard for hydrographic surveys. The standard classifies surveys into 
survey orders (Special Order, Orders 1a, 1b, 2) based on an area’s 
importance for safety of surface navigation. 

S-57 S-57 is the international standard developed and maintained by the 
International Maritime Organization (IMO). It is used by hydrographic data 
producers to describe how real-world entities are stored digitally for transfer 
among different computer platforms between the various hydrographic 
offices.
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session Saving a session will record all the data: survey line names, background 
raster images and field sheets, that are currently open in the HIPS and 
SIPS interface. This enables you to re-open an integrated data set from a 
previous working session.

 SHOALS Scanning Hydrographic Airborne Lidar Survey (SHOALS) is a LIDAR 
system owned and operated by the Joint Airborne Lidar Bathymetry Center 
of Expertise. 

side scan The emission of sonar pulses in a wide angle perpendicular to the seafloor 
to port and starboard that are received and logged as a time series of 
intensities in order to form an image. This data is logged separately from 
the bathymetry data. A swath multibeam system forms two additional 
receive beams in addition to the bathymetry profile.

slant range Raw travel time used to compute sounding depth (accompanied by receive 
angle). 

Slant Range Corrected 
Side Scan

Time-indexed imagery profiles generated from raw side scan data using the 
measured altitude of the transducer. The across-track scale is distance in 
metres.

sounding A measured depth of water.

Sounding datum 
height

Distance from the ellipsoid to the sounding datum.

Sound Velocity 
Correction

The process of applying rigorous refraction corrections to the raw travel 
time/angle bathymetry data using recorded sound velocity profiles.

Status Flag The indicator of the acceptance or rejection of a data point during cleaning. 

subset A rectangular area which encloses some or all of a survey project 
represented in the Display window. It is used during sounding cleaning to 
limit the number and extent of soundings being processed during one 
session. 

surface cleaning A statistical process of detecting bathymetric outliers within an area. A least 
square polynomial regression algorithm is used.
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tiles A representation of the sea floor consisting of interlocking tiles of varying 
sizes. Tiles can make large data sets more manageable by subdividing 
them by user-defined criteria.
Tile positions are defined by a Morton Number scheme. Tiles can carry a 
variety of attributes generated from the data within the area of the tile.

time series A series of intensity values (dB) logged with each beam that is added based 
on the time and range of detection point to assemble a trace similar to a 
side scan image. Each individual time series is associated with a portion of 
the bathymetric profile.
This detection method allows for a higher across-track spatial resolution of 
seafloor features (with spatial frequencies higher than the beam spacing) 
since a portion of the time series is preserved for each beam.

Time-Varying Gain 
(TVG)

The attenuation of acoustic energy that occurs due to absorption and 
spreading as the sonar beam travels back to the receiver, resulting in a 
non-uniform gain across the swath. Since signal returns are received over 
a predictable and constant time period, a correction can be used to adjust 
the signal intensity by applying a non-uniform, time dependent gain.

TIN A triangulated irregular network (TIN) is a digital terrain model which 
consists of a series of triangles with the data points as vertices. A TIN uses 
the actual elevation for each data point.

tortuosity A unitless advanced Geocoder parameter indicating the characteristic of 
flow through porous media, or twisting of the pore space. This is a factor in 
the Biot model, and smaller numbers (1 is the minimum value) indicate a 
straighter path of potential flow, while higher numbers would have a more 
twisted path.

total backscatter Combination of backscatter that occurs due to the interface change 
(Interface Backscatter), sediment heterogeneities (Volume Backscatter), 
and roughness of the sediment (Kirchkov Backscatter).

TrueHeave A heave filtering function developed by Applanix. TrueHeave employs a bi-
directional heave filter to remove artifacts from heave data. Values are 
computed from real-time data and have to be imported separately to the 
track line.

TPU Total Propagated Uncertainty. TPU is derived from a combination of all 
individual error sources and is used to calculate horizontal and vertical 
uncertainties for soundings.

vessel A survey platform, whether it be a ship, a towfish, an ROV/AUV, or an 
aircraft.
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velocity A unitless advanced Geocoder parameter measuring the ratio of sediment 
sound speed to water sound speed.

volume backscatter Scattering of the transmitted acoustic energy into the seafloor by 
heterogeneities in the sediment structure.

weighted grid A georeferenced TIFF representation of the mean sea floor depths derived 
from processed bathymetry, that was used in HIPS before the introduction 
of the BASE surface. 
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